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Informazioni su Normative e Sicurezza

Questo capitolo contiene informazioni generali relative alla sicurezza, descrive i simboli e le
convenzioni utilizzate nella documentazione, e fornisce informazioni sulla conformita alle
normative. Descrive anche i rischi, i pericoli e le relative avvertenze per il sistema, nonché le
precauzioni che dovrebbero essere prese per ridurre al minimo i rischi. In aggiunta a questo
capitolo, fare riferimento alla Guida alla Pianificazione del Sito per i requisiti del sito, compresa la
fornitura elettrica, lo scarico della sorgente, la ventilazione, I'aria compressa, I'azoto e la pompa
per vuoto primaria.

Informazioni Generali sulla Sicurezza

Prima di utilizzare qualsiasi sistema, provvedere a istruirsi sul suo funzionamento e sui potenziali
pericoli. Per evitare infortuni o danni al sistema, leggere, comprendere e rispettare tutte le
precauzioni di sicurezza. Le avvertenze in questo documento e le etichette sul spettrometro di
massa sono contrassegnate con simboli internazionali. La mancata osservanza di queste
avvertenze potrebbe causare infortuni gravi.

Queste informazioni di sicurezza sono destinate ad integrare le normative federali, statali o
provinciali e locali su salute, ambiente e sicurezza (SAS). Le informazioni fornite coprono la
sicurezza relativa al sistema per quanto riguarda il funzionamento del spettrometro di massa.
Non coprono tutte le procedure di sicurezza che dovrebbe essere messe in atto. In definitiva, il
Cliente e la Sua organizzazione sono responsabili della conformita alle normative federali, statali
o provinciali e locali su salute, ambiente e sicurezza (SAS) e della sicurezza dell'ambiente di
laboratorio.

Per ulteriori informazioni, consultare il materiale di riferimento appropriato e le procedure
operative standard per il laboratorio.

Simboli e Convenzioni

Le seguenti convenzioni sono presenti nella guida.

o fatali.

.f PERICOLO!La dicitura Pericolo indica un'azione che puo causare infortuni gravi

che potrebbe causare infortuni alla persona se non sono prese le adeguate

2 AVVERTENZA!Pericolo di Infortunio: La dicitura Avvertenza indica un'operazione
precauzioni.

Guida per I'Utente Strumenti AB SCIEX Serie 6500
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Informazioni su Normative e Sicurezza

AVVERTENZA!Pericolo di Scosse Elettriche: Questo simbolo richiama

A all'attenzione riguardo il pericolo di scosse elettriche. Leggere I'avvertimento e
adottare tutte le dovute precauzioni prima di effettuare qualsiasi operazione
descritta nella guida. La mancata applicazione di quanto consigliato potrebbe
causare infortuni gravi.

riguardo il rischio di bruciatura da superfici calde. Leggere I'avvertimento e
adottare tutte le dovute precauzioni prima di effettuare qualsiasi operazione
descritta nella guida. La mancata applicazione di quanto consigliato potrebbe
causare infortuni gravi.

2 AVVERTENZA!Pericolo di Scottatura: Questo simbolo richiama all’attenzione

riguardo la presenza di materiali a rischio biologico. Leggere I'avvertimento e
adottare tutte le dovute precauzioni prima di effettuare qualsiasi operazione
descritta nella guida. La mancata applicazione di quanto consigliato potrebbe
causare infortuni gravi.

2 AVVERTENZA!Rischio Biologico: Questo simbolo richiama all'attenzione

Attenzione:La dicitura Attenzione indica un operazione che potrebbe causare danni al
sistema o una perdita di dati se non si prendono le dovute precauzioni.

procedure presenti nel testo per una specifica necessita, e contiene collegamenti a parti

< Suggerimento!Fornisce informazioni utili che aiutano nell'applicazione di tecniche e
/
> del testo, ma non é essenziale per il completamento di una procedura.

“«su Nota: Una nota mette in risalto delle informazioni importanti in una procedura o in una
descrizione.

Personale Qualificato

Dopo aver installato il sistema, il FSE (Field Service Employee - Responsabile dell'Assistenza
Tecnica) usera la Lista di Controllo per la Formazione Breve per formare il cliente riguardo il
funzionamento, la manutenzione di base e la pulizia del sistema. Solo il

personale qualificato interno ad AB SCIEX dovra installare il sistema e condurre le riparazioni
sullo stesso. Solo il personale qualificato da AB SCIEX dovra utilizzare il sistema e svolgere la
manutenzione sullo stesso. Contattare un Responsabile dell'Assistenza Tecnica (FSE) di AB
SCIEX per maggiori informazioni.

Uso e Modifiche dell’Apparecchiatura

Usare il sistema al coperto, in un laboratorio conforme alle condizioni ambientali raccomandate

nella Guida alla Pianificazione del Sito. Se il sistema viene utilizzato in un ambiente o in un modo
non conforme a quanto specificato da AB SCIEX, la protezione fornita dall'apparecchiatura pu®

essere compromessa.
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Informazioni su Normative e Sicurezza

Le modifiche o il funzionamento non autorizzato del sistema possono causare infortuni e danni
alle apparecchiature, oltre che invalidare la garanzia. Possono essere generati dati non affidabili
se il sistema € usato in condizioni che eccedono i parametri delle condizioni ambientali
raccomandate o se vi sono state apportate modifiche non autorizzate. Contattare un
rappresentante di AB SCIEX per ulteriori informazioni sulle riparazioni al sistema.

Etichette di Spedizione

Tabella 1-1 Etichette sulla Cassa

Etichette Esterne

Definizione

Azione

MONITORED SHIPMENT

IF TIP (N) TELL ARROW POINT IS BLUE THIS
PACKAGE HAS BEEN ON ITS SIDE OR TIPPED
OVER IN TRANSIT.

MAKE NOTE ON BILL OF LADING AND CHECK
FOR DAMAGE, ANY CLAIMS FOR TIPPING
DEPEND ON THIS NOTATION.

~
~

RE
\\‘. _N_
iTELC

Indicatore Tip'n'Tell

La presenza delle due gocce
blu nella freccia indica che |l
collo & stato rovesciato o ha
subito urti durante il trasporto.

Riportare il problema sulla
Bolla di Carico e controllare se
ci sono stati danni. Ogni
reclamo relativo al
rovesciamento deve essere
messo per iscritto.

Conformita alle Normative

Questo sistema & conforme alle norme e alle normative elencate in questa sezione. Le relative
etichette sono state affisse al sistema.

Australia e Nuova Zelanda
* Interferenza Elettromagnetica—AS/NZ CISPR 11 (Class A)

Guida per I'Utente
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Informazioni su Normative e Sicurezza

e Sicurezza—AS/NZ 61010-1

Canada

* Interferenza Elettromagnetica—CAN/CSA CISPR11. Il sistema ISM & conforme
alla norma canadese ICES-001.

+ Sicurezza—CAN/CSA C22.2 Num. 61010-1, e CAN/CSA C22.2 Num. 61010-2-061

Europa

+ Compatibilita Elettromagnetica—EN 55011 (Class A), EN 61326-1
+ Sicurezza—EN 61010-1, EN 61010-2-061
+  WEEE—2002/96/CE

Stati Uniti

* Interferenza Elettromagnetica, FCC Part 15, Class A— Questa apparecchiatura &
stata testata ed ¢ risultata conforme ai limiti dei dispositivi digitali di Classe A,
seguenti alla Parte 15 delle Normative FCC (Federal Communications Commission
Compliance). Questi limiti sono concepiti per offrire una protezione ragionevole
contro le interferenze dannose quando l'apparecchiatura viene utilizzata in un
ambiente aziendale. Questa apparecchiatura genera, utilizza e pud irradiare energia
a radiofrequenza e, se non installata e utilizzata secondo il manuale dell'operatore,
puod causare interferenze dannose alle comunicazioni radio. L'uso di questa
apparecchiatura in un'area residenziale pud causare interferenze dannose. Se gl
sara richiesto di eseguire gli interventi correttivi necessari, il Cliente dovra
provvedere a proprie spese. | cambiamenti o le modifiche non espressamente
approvati dal costruttore possono rendere nulla I'autorizzazione ad utilizzare
I'apparecchiatura.

» Sicurezza—UL 61010-1, IEC 61010-2-061

Internazionali

+ Compatibilita Elettromagnetica—IEC 61326-1, IEC CISPR 11 Class A
+ Sicurezza—IEC 61010-1, IEC 61010-2-061

Per ulteriori informazioni, consultare la Declaration of Conformance (Dichiarazione di
Conformita) inclusa nel sistema.

Strumenti AB SCIEX Serie 6500 Guida per I'Utente
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Informazioni su Normative e Sicurezza

Simboli ed Etichette sullo Spettrometro di Massa

Tabella 1-2 Etichette sullo Spettrometro di Massa

Etichette Esterne

Definizione

WARNING:
NO USER SERVICEABLE PARTS INSIDE.
REFER SERVICING TO QUALIFIED PERSONNEL.

AVVERTENZA: NON CONTIENE PARTI
RIPARABILI DALL'UTENTE. AFFIDARE LA
RIPARAZIONE AL PERSONALE QUALIFICATO.

EN61326—1:2006
CLASS A, GROUP 1,
ISM EQUIPMENT.

EN61326—1:2006 APPARECCHIATURA DI
CLASSE A, GRUPPO 1, ISM

This ISM device complies with Canadian ICES-001.
Cet appareil ISM est conforme & la norme NMB-001

du Canada.

Il sistema ISM & conforme alla norma canadese
ICES-001.

Questa apparecchiatura ISM & conforme alla norma
canadese NMB-001.

This device complies with Part 15 of the FCC Rules

( FCC Compliance W

Operation is subject to the following two conditions:

including interference that may cause undesired operation

(1) this device may not cause harmful interference, and
(2) this device must accept any interference received,
0211-31989

Conformita alla FCC. Questa apparecchiatura é
conforme alla Parte 15 delle Normative FCC (Federal
Communications Commission Compliance). L'uso &
soggetto alle seguenti condizioni: (1) questo
dispositivo non deve causare interferenze dannose e
(2) questo dispositivo deve accettare ogni
interferenza ricevuta, incluse le interferenze che
possono causare un funzionamento non desiderato.

Non smaltire I'apparecchiatura nei rifiuti comuni non
differenziati (WEEE).

SOLO PER SCOPI DI RICERCA. NON
USARE NELLE PROCEDURE
DIAGNOSTICHE.

Questo sistema & concepito solo per scopi di ricerca.
Non & concepito per I'uso nelle procedure
diagnostiche.

/1

MINIMUM OF SIX PERSONS REQUIRED
TO SAFELY LIFT THIS EQUIPMENT

Attenzione: consultare i documenti di
accompagnamento.

E richiesto un numero minimo di sei persone per
sollevare in sicurezza questa apparecchiatura.

Guida per I'Utente
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Informazioni su Normative e Sicurezza

Tabella 1-2 Etichette sullo Spettrometro di Massa (Continua)

Etichette Esterne Definizione
AVVERTENZA: Pericolo - Superfici Calde

Guida per I'Operatore

Seguire le istruzioni per l'uso (obbligatorio)

Corrente Alternata

Ampere (corrente)
Alta tensione. Pericolo di Scosse Elettriche

On (Rete elettrica)

Off (Rete elettrica)

Messa a Terra (protezione)

Volt (tensione)
V-A Volt - Ampere (potenza)
w Watt (potenza)

Simboli di Salute e Sicurezza sul Lavoro

Questa sezione descrive alcuni simboli riguardanti la sicurezza e la salute sul lavoro presenti in
ambiente di laboratorio.

Tabella 1-3 Simboli di Rischio Chimico

Simbolo di Sicurezza Descrizione
2 Rischio Biologico
Strumenti AB SCIEX Serie 6500 Guida per I'Utente
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Informazioni su Normative e Sicurezza

Tabella 1-3 Simboli di Rischio

Chimico (Continua)

Simbolo di Sicurezza

Descrizione

Pericolo di Esposizione ad Agenti Chimici Corrosivi o Caustici

Pericolo di Esplosione

Pericolo di Esposizione ad Agenti Chimici Comburenti

B> B P B

Pericolo di Avvelenamento

To<

Pericolo di Esposizione ad Agenti Chimici Instabili

3

Pericolo di Esposizione ad Agenti Chimici Tossici

Tabella 1-4 Simboli di Rischio

Meccanico

Simbolo di Sicurezza

Descrizione

Pericolo di Impianti Automatizzati

Pericolo di Schiacciamento - Dall'Alto

Pericolo di Schiacciamento - Dal Lato

Pericolo di Incendio

Pericolo di Superfici calde

> BB BB

Pericolo di Radiazione Laser

Guida per I'Utente
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Informazioni su Normative e Sicurezza

Tabella 1-4 Simboli di Rischio Meccanico (Continua)

Simbolo di Sicurezza Descrizione

Pericolo di Sollevamento

Pericolo Magnetico

Pericolo di Perforazione

& > P

Tabella 1-5 Simboli di Rischio : Gas sotto Pressione

Simbolo di Sicurezza Descrizione

2 Pericolo di Gas sotto Pressione

Prodotti Chimici

Adottare le seguenti precauzioni in materia di salute e sicurezza quando si lavora con i prodotti

chimici:

Leggere le Schede di Sicurezza se non si ha gia confidenza con i prodotti chimici
che si stanno usando e le precauzioni in materia di salute e sicurezza che devono
essere adottate.

Indossare sempre i dispositivi di protezione individuale assegnati, inclusi guanti in
nitrile privi di polvere, occhiali di sicurezza e camice da laboratorio.

Lavorare in un ambiente ben ventilato.
Seguire le norme di sicurezza relative ai lavori in presenza di elettricita.

Evitare le potenziali fonti di scintille quando si lavora coi materiali infiammabili, come
alcool isopropilico, metanolo e altri solventi infiammabili.

Evitare il contatto dei prodotti chimici con la pelle durante la pulizia e lavare le mani
dopo l'uso.

Fare la massima attenzione nell'uso e nello smaltimento dei prodotti chimici e agire
in conformita con le normative locali per evitare il rischio di infortuni gravi.

Strumenti AB SCIEX Serie 6500 Guida per I'Utente
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Informazioni su Normative e Sicurezza

Rete Elettrica

qualificato per l'installazione di tutte le apparecchiature elettriche e gli elementi
dell'impianto, e assicurarsi che tutte le installazioni siano in conformita con le
normative in vigore in loco.

2 AVVERTENZA!Pericolo di Scosse Elettriche: Rivolgersi solo a personale

Il consumo totale combinato del sistema (spettrometro di massa e pompe per vuoto) &€ 2200 VA
(50 Hz 0 60 Hz) a 230V CA.

Non & necessario un trasformatore esterno per lo spettrometro di massa, il banco opzionale o le
pompe per vuoto.

Attenzione:Non disimballare o collegare alcun componente. Il responsabile
dell'assistenza tecnica (FSE) di AB SCIEX si occupera di disimballare, collegare e
configurare il sistema secondo la tensione di esercizio richiesta.

Per informazioni sulle specifiche dell'impianto elettrico, fare riferimento alla Guida alla
Pianificazione del Sito.

Conduttore di Terra

La rete elettrica deve includere un conduttore di terra installato correttamente, che deve essere
installato o controllato da un elettricista qualificato prima di essere connesso allo spettrometro di
massa.

Non interrompere intenzionalmente il conduttore di terra. Ogni interruzione del conduttore di terra
pud rendere l'installazione pericolosa.

Ventilazione del Laboratorio

L'areazione dei fumi e lo smaltimento dei rifiuti devono avvenire in conformita con tutte le
normative in materia di salute e sicurezza a livello federale, statale, provinciale e locale. Usare il
sistema al coperto, in un laboratorio conforme alle condizioni ambientali raccomandate nella
Guida alla Pianificazione del Sito per il sistema. Il sistema di scarico della sorgente deve essere
collegato a una cappa aspirante esterna o a un impianto di scarico verso l'esterno, come
raccomandato nella Guida alla Pianificazione del Sito per il sistema.

AVVERTENZA!Pericolo di Contaminazione da Radiazioni o Esposizione ad Agenti
Chimici Tossici e Biologici. Non usare lo spettrometro di massa se il tubo di
scarico della sorgente non é collegato con I'impianto di ventilazione del

ﬁ laboratorio.

[>
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Informazioni su Normative e Sicurezza

Condizioni Ambientali

Rivolgersi a personale qualificato per l'installazione di apparecchiature ed elementi dell'impianto
elettrico, di riscaldamento, di ventilazione e idraulico. Assicurarsi che tutte le installazioni siano
in conformita con le leggi in vigore in loco e con le normative in tema di rischio biologico. Per
ulteriori informazioni sulle condizioni ambientali richieste per il sistema, fare riferimento alla
Guida alla Pianificazione del Sito per il sistema.

PERICOLO!Pericolo di Esplosione: Non usare il sistema in un ambiente che
contiene gas esplosivi. Il sistema non é progettato per essere usato in ambienti
contenenti gas esplosivi.

B

AVVERTENZA!Pericolo di Soffocamento: Assicurarsi che la ventilazione dei gas
A esausti avvenga in maniera corretta. L'uso degli spettrometri di massa senza una
ventilazione adeguata verso I'esterno pudé comportare rischi per la salute. In
aggiunta, alcune procedure richieste durante I'uso dello spettrometro di massa
possono causare I'immissione dei gas nel flusso degli scarichi; in queste

condizioni una ventilazione inadeguata pué causare gravi infortuni.

AVVERTENZA!Pericolo di Contaminazione da Radiazioni ed Esposizione ad
Agenti Tossici Chimici e Biologici: Assicurarsi che il sistema sia connesso al
sistema di scarico locale e debitamente canalizzato per tenere le emissioni

é pericolose sotto controllo. Il sistema deve essere usato solo in un ambiente di

>

laboratorio ben ventilato, in conformita con le normative locali e con un ricambio
dell'aria appropriato per il lavoro da svolgere.

Negli Stati Uniti la norma OSHA 29 CFR Part 1910-1450 richiede da 4 a 12 ricambi
dell'aria I'ora in laboratorio.

AVVERTENZA!Rischio Biologico: Quando si usano materiali che comportano un

@ rischio biologico, applicare sempre le normative locali in tema di valutazione,
controllo e gestione del rischio. Questo spettrometro di massa o qualsiasi sua
parte non é progettato per funzionare come una cabina di contenimento biologico
di sicurezza.

Smaltimento del Sistema (Rifiuti Elettrici ed
Elettronici)

Non smaltire i componenti o le unita del sistema, incluse le parti dei computer, nei rifiuti comuni
non differenziati. Seguire le norme locali € comunali per le disposizioni appropriate in tema di
smaltimento per ridurre I'impatto ambientale dei c.d. WEEE (rifiuti elettrici ed elettronici). Per
assicurare un corretto smaltimento di queste apparecchiature, contattare un Responsabile
dell'Assistenza Tecnica per ricevere istruzioni.

Clienti Residenti nell'Unione Europea: Contattare il Servizio Assistenza AB SCIEX locale per la
raccolta e il riciclaggio delle apparecchiature complementari.

Strumenti AB SCIEX Serie 6500 Guida per I'Utente
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Informazioni sul Sistema

Gli strumenti AB SCIEX Serie 6500 sono destinati all'analisi qualitativa e quantitativa di specie
chimiche. Il sistema &€ composto da uno spettrometro di massa, un banco (opzionale), una
sorgente ionica, un computer e il software Analyst®.

Principi Teorici di Funzionamento

La spettrometria di massa misura il rapporto massa/carica degli ioni per identificare composti
sconosciuti, per quantificare composti noti e per fornire informazioni sulle proprieta strutturali e
chimiche delle molecole.

Gli strumenti della serie 6500 hanno una serie di filtri quadrupolari che trasmettono gli ioni
secondo il valore del loro rapporto massa/carica (m/z). Il primo quadrupolo in questa serie € la
guida ionica QJet™, situata tra il separatore di vuoto e la regione del Q0. La guida ionica QJet
non filtra gli ioni, ma li focalizza prima che entrino nella regione del Q0. Focalizzando
preventivamente il flusso di ioni creato dall'orifizio piu largo, la guida ionica Qjet aumenta la
sensibilita dello strumento e migliora il rapporto segnale-rumore. Gli ioni sono nuovamente
focalizzati nella regione del QO prima che passino nel quadrupolo Q1.

Il quadrupolo Q1 & un quadrupolo filtrante che ordina gli ioni prima che gli stessi entrino nella
camera di collisione Q2. Nella camera di collisione Q2 I'energia interna degli ioni & incrementata
attraverso le collisioni con molecole di gas, al punto che i legami molecolari si rompono creando
ioni prodotto. Questa tecnica permette agli utenti di progettare esperimenti che misurano il
rapporto m/z degli ioni prodotto, in modo da determinare la composizione degli ioni genitori.

Dopo il passaggio attraverso la camera di collisione Q2, gli ioni entrano nel quadrupolo Q3 per
un filtraggio supplementare e infine sono immessi nel rivelatore. Nel rivelatore gli ioni creano una
corrente che viene convertita in un impulso di tensione. Gli impulsi di tensione in uscita dal
rivelatore sono direttamente proporzionali alla quantita di ioni che entrano nel rivelatore. I
sistema osserva questi impulsi di tensione e converte le informazioni in un segnale. Il segnale
rappresenta l'intensita dello ione per un particolare valore di m/z e il sistema visualizza questa
informazione per mezzo di uno spettro di massa.

Gestione dei Dati

Il software Analyst necessita di un computer con installato il sistema operativo Windows. I
computer, con il software di sistema incluso, usa il controller di sistema e il firmware associato
per controllare lo strumento e I'acquisizione dei dati. Durante il funzionamento del sistema, i dati
acquisiti sono inviati al software Analyst dove possono essere visualizzati in forma di spettri di
massa completi, di intensita degli ioni singoli o multipli rispetto al tempo, o corrente ionica totale
rispetto al tempo.

Panoramica del Sistema

La Figura 1-1 mostra un sistema con pompa a sirin%a, sorgente ionica, valvola deviatrice e i
monitor opzionali per la sorgente ionica NanoSpray™.

Guida per I'Utente Strumenti AB SCIEX Serie 6500
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Figura 1-1 Vista Frontale

Elemento | Descrizione Per ulteriori informazioni, fare riferimento a...
1 Simboli del pannello Tabella 1-1 a pagina 20.
2 Monitor per la sorgente La Guida per I'Operatore della Sorgente lonica
ionica NanoSpray NanoSpray® € disponibile al menu Help del software
(opzionali) Analyst o sul sito AB SCIEX all'indirizzo

www.absciex.com.

3 Pompa a siringa Regolare la Posizione della Pompa a Siringa
Integrata a pagina 24.

4 Sorgente ionica La Guida per I'Operatore della Sorgente lonica
lonDrive™ Turbo V & disponibile al menu Help del
software Analyst o sul sito AB SCIEX all'indirizzo
www.absciex.com..

5 Valvola deviatrice Se la sorgente ionica opzionale DuoSpray™ &
installata, la valvola deviatrice & sostituita dalla
valvola DuoSpray. La valvola deviatrice € installata
sotto la valvola DuoSpray. Fare riferimento a
Configurare la Pompa a Siringa Integrata a

pagina 26.

Per informazioni sulla sorgente ionica DuoSpray, fare
riferimento alla Guida per I'Operatore della Sorgente
lonica DuoSpray™ disponibile al menu Help del
software Analyst o sul sito AB SCIEX all'indirizzo
www.absciex.com.
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Informazioni sul Sistema

La Figura 1-2 mostra la posizione dei collegamenti del sistema, comprese le posizioni dei

pulsanti Reset e Vent e l'interruttore generale.

Figura1-2 Viste Posteriore e Laterali

Elemento | Descrizione

Per maggiori informazioni...

1 Innesto del vuoto della pompa Contattare un responsabile dell'assistenza
primaria tecnica (FSE) di AB SCIEX.
2 Innesto di erogazione gas azoto Contattare un responsabile dell'assistenza

(erogazione Curtain Gas™, gas CAD)

tecnica (FSE) di AB SCIEX.

(Su = On; Giu = Off)

3 Innesto di scarico della sorgente Contattare un responsabile dell'assistenza
tecnica (FSE) di AB SCIEX.

4 Connettore di comunicazione della Contattare un responsabile dell'assistenza

sorgente tecnica (FSE) di AB SCIEX.

5 Pulsante di reset dello strumento Fare riferimento a Reset del Sistema a
pagina 21.

6 Connessione rete elettrica Fare riferimento a Avviare il Sistema. a
pagina 20 o Arresto del Sistema. a
pagina 21.

7 Interruttore generale dello strumento | Fare riferimento a Avviare il Sistema. a

pagina 20 o Arresto del Sistema. a
pagina 21.

Guida per I'Utente
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Figura 1-2 Viste Posteriore e Laterali (Continua)

Elemento | Descrizione Per maggiori informazioni...
8 Connettore 1/0O Aux Fare riferimento Guida alla
Configurazione delle Periferiche.
9 Connettore Ethernet (connette lo Contattare un responsabile dell'assistenza
strumento e il computer) tecnica (FSE) di AB SCIEX.
10 Pulsante di spurgo (spegnimento) Fare riferimento a Avviare il Sistema. a
dello strumento pagina 20 o Arresto del Sistema. a
pagina 21.
11 Scarico rifiuti della sorgente (al Contattare un responsabile dell'assistenza
contenitore di raccolta rifiuti) tecnica (FSE) di AB SCIEX.
12 Innesto erogazione aria (Gas1/Gas2) | Contattare un responsabile dell'assistenza
tecnica (FSE) di AB SCIEX.

Simboli del pannello

La Tabella 1-1 mostra i LED di stato.
Tabella 1-1 Simboli del pannello

LED del pannello Colore Nome Descrizione
Verde Power Si accende quando il sistema € in
w - funzione.
Verde Vacuum Si accende quando & stato raggiunto il
v - vuoto impostato e lampeggia se il vuoto
non & al valore corretto (durante la

riduzione di pressione e lo spurgo).

G — Verde

Ready Acceso quando il sistema & in stato di
Ready. Il sistema deve essere in stato di
l. - Ready per iniziare le operazioni.
Blu Scanning Lampeggia quando il sistema sta
& —— acquisendo i dati.
Rosso Fault Si accende quando il sistema va incontro

a un errore o0 un guasto.

Quando si accende il sistema, tutti e cinque i LED si illuminano. I LED Power resta acceso. Gli
altri quattro LED lampeggiano per due secondi, poi si spengono. Il LED Vacuum comincia a
lampeggiare. Dopo che il vuoto prestabilito & stato raggiunto, questo LED resta acceso.

Avviare il Sistema.

il sistema deve essere spostato, contattare un Responsabile dell'Assistenza

'& AVVERTENZA!Pericolo di Infortunio. Rischio di infortunio o danni al sistema. Se
Tecnica (FSE).
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e/l Nota: Prima di usare il sistema, leggere le Informazioni su Normative e Sicurezza a
pagina 7.

Prima che il sistema sia avviato, assicurarsi che tutti i requisiti specificati nella Guida alla
Pianificazione del Sito siano soddisfatti. Questa guida comprende informazioni sulle connessioni
alla rete elettrica, sullo scarico del sistema, I'aria compressa, |'azoto, le pompe per vuoto, la
ventilazione, gli scarichi e gli spazi liberi del sito.

1.

Assicurarsi che I'accesso al cavo di alimentazione sia libero. |l cavo di alimentazione
deve essere accessibile allo scopo di disconnettere lo spettrometro di massa dalla
Rete CA.

Assicurarsi che il contenitore di scarico da 4 L sia connesso all'uscita Exhaust Waste
(Scarico Rifiuti) sul retro dello spettrometro di massa e al sistema di ventilazione del
laboratorio.

Assicurarsi che il cavo di alimentazione di rete sia collegato allo spettrometro di
massa.

Assicurarsi che i cavi di alimentazione dello spettrometro di massa e della pompa
per vuoto primaria siano inseriti nelle prese da 200 V a 240 V della rete elettrica.

Assicurarsi che il cavo Ethernet sia collegato allo spettrometro di massa e al
computer.

Avviamento dello spettrometro di massa.

] Nota: Se l'interruttore € gia in posizione ON, spegnere e riaccendere.

Lo spettrometro di massa si avvia, quindi la pompa per vuoto si avvia dopo 30
secondi.

Accendere il computer, se spento.
Lanciare il software Analyst®.
Fare clic su View > Sample Queue, poi fare clic sull'icona Ready.

Reset del Sistema

Premere e tenere premuto il tasto Resetper 5 secondi.

Si avvertira un clic quando si connette il relé. Dopo circa tre minuti lo spettrometro di
massa dovrebbe raggiungere la pressione di esercizio.

Arresto del Sistema.

1.

Completare le scansioni in corso o fare clic su Acquire > Abort Sample per
interrompere. Fare riferimento a Arrestare I'Acquisizione dei Campioni a pagina 68.

Attenzione:Rischio di Danni Allo Strumento: Arrestare il flusso del campione
prima di spegnere il sistema.

Guida per I'Utente Strumenti AB SCIEX Serie 6500
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Arrestare il flusso del campione verso lo spettrometro di massa.

3. Nel software Analyst, disattivare il profilo hardware (se attivo), chiudere
I'applicazione, quindi terminare il servizio Analyst.exe.

Attenzione:Rischio di Danni Allo Strumento: Se lo strumento deve restare
spento per un certo periodo di tempo, spurgare la camera da vuoto per
impedire che lo scarico dalla pompa per vuoto sia risucchiato nuovamente
nella camera da vuoto.

4. Premere e tenere premuto il tasto Vent (Spurgo) per 5 secondi.

La rotazione della pompa turbo diminuira gradualmente. Le pompe per vuoto sono
controllate dal sistema e continueranno a girare per 15 minuti.

5. Attendere 15 minuti, quindi spegnere lo spettrometro di massa.

6. Scollegare il cavo di alimentazione elettrica dalla sua sede nel lato sinistro dello
spettrometro di massa.

7. Scollegare i cavi di alimentazione di ciascuna pompa per vuoto dalla rete elettrica.

Configurare il Profilo Hardware per la Pompa a
Siringa Integrata

Assicurarsi che la pompa a siringa sia posta in sede correttamente per evitare di danneggiare la
siringa. Per ulteriori informazioni circa la creazione e le modifiche dei profili hardware, fare
riferimento a Create a Hardware Profile a pagina 7.

1. Nella Barra di Navigazione, alla voce Configure, fare doppio clic su Hardware
Configuration.

Creare o modificare il profilo hardware che contiene lo spettrometro di massa.

3. Nella casella Devices in current profile, selezionare lo spettrometro di massa e
fare clic su Setup Device.

4. Nella scheda Configuration (Figura 1-3), selezionare Use integrated syringe
pump.
5. Fare clic su OK.
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X

Mass Spectrometer,

Configuration | Communication

Aliaz: |

Synchronization Trigger
() Active low
(O Active high

Mate: Scanning will be tiggered by a 0% signal if the
Active Low spnchronization trigger is selected.

Settings for Integrated D evices

[ Use integrated injectar/diverter valve

2

DuoSpray lon Source Switching Y alve Counter

Count; | 0 | [ Reset Counter

Dual M azs Mode
(@) Low Mass
() High Mass

[ 0k, ][ Cancel ][ Help

Figura1-3 Scheda Configuration
6. Attivare il profilo hardware.

Guida per I'Utente Strumenti AB SCIEX Serie 6500
23 di 132



Informazioni sul Sistema

Regolare la Posizione della Pompa a Siringa
Integrata

1. Premere il pulsante Release sul lato destro della pompa a siringa per abbassare la
base e inserire la siringa come mostrato in Figura 1-4.

Assicurarsi che I'estremita della siringa sia a filo con la base e che il poggiadita della
siringa sia posizionato nella fessura.

Figura 1-4 Abbassamento della siringa

Elemento | Descrizione

1 Stantuffo della siringa.

2 Pulsante Release. Premere per alzare o abbassare la base.

2. Regolare il perno (Figura 1-5) in modo che possa azionare il fine corsa automatico
della siringa prima che lo stantuffo colpisca il fondo della siringa in vetro.
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N

Figura 1-5 Fine corsa di sicurezza

Elemento | Descrizione

1 Fine corsa automatico della siringa. Quando il perno colpisce il fine
corsa automatico della siringa, la pompa a siringa si arresta.

2 Perno. Regolare I'altezza in modo tale che lo stantuffo della siringa
non colpisca la siringa durante l'infusione del campione.

3 Vite di bloccaggio del perno. Serrare la vite dopo che l'altezza del
perno é stata regolata.

3. Girare le viti laterali come mostrato in Figura 1-6 per fissare la siringa.

Figura 1-6 Pompa a siringa
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4. Premere il bottone sul lato destro della pompa a siringa (Figura 1-7) per avviare il
flusso nello spettrometro di massa.

La spia verde di fianco al pulsante si illumina quando la pompa a siringa € in uso.

~ Suggerimento!La pompa a siringa puo essere avviata anche tramite il
/ software Analyst in modalita Manual Tuning.

&

Figura1-7 LED Pompa a siringa

Elemento | Descrizione

1 LED di stato della pompa a siringa

2 Pulsate on/off della pompa a siringa

Configurare la Pompa a Siringa Integrata
1. Nella Barra di Navigazione, alla voce Acquire, fare doppio clic su Build Acquisition
Methods.
2. Nelriguadro Acquisition method , fare clic sull'icona Syringe Pump.

La scheda Syringe Pump, contenente le proprieta del metodo, si aprira nel riquadro
Acquisition Method Editor.

3. Nel campo Syringe Diameter (mm) , immettere il diametro della siringa.
4. Nel campo Flow Rate, immettere la velocita di flusso.
5. Nell'elenco Unit, scegliere le unita di flusso.
6. Salvare il file.
Strumenti AB SCIEX Serie 6500 Guida per I'Utente
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Configurare la Valvola Deviatrice

La valvola deviatrice € una valvola a due posizioni con 6 attacchi. Se la valvola € in Posizione A
(Figura 1-9), il campione scorre attraverso il loop esterno. Quando la valvola passa in Posizione
B (Figura 1-10), il campione viene iniettato. Per ulteriori informazioni circa la creazione e le
modifiche dei profili hardware, fare riferimento a Create a Hardware Profile a pagina 7.

1. Nella Barra di Navigazione, alla voce Configure, fare doppio clic su Hardware
Configuration.

Creare o madificare il profilo hardware che contiene lo spettrometro di massa.

Nella scheda Configuration (Figura 1-8), selezionare Use integrated injector/
diverter valve.

4. Fare clic su OK.

Mass Spectrometer @

Configuration | Communication

Alias

Synchionization Trigger
(3 Asctive low
() dsctive high

Mote: Scanning will be triggered by a 0 signal if the
Active Low synchronization trigger is selected.

Settings for Integrated Devices

ted injector/diverter valve

i

DuoSpray lon Source Switching W alve Counter

Dual Mazs Mode
(%) Low Mass
() High Mass
l 0K ] [ Cancel ] [ Help

Figura 1-8 Scheda Configuration
5. Attivare il profilo hardware.
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Collegamenti della Valvola Deviatrice

La valvola deviatrice deve essere collegata sia in modalita iniettore, sia in modalita deviatore.

Collegare la Valvola Deviatrice in Modalita Iniettore

La valvola deviatrice &€ una valvola a due posizioni con 6 attacchi. Se si pone la valvola in

Posizione A (Figura 1-9), il campione scorre attraverso il loop esterno. Quando la valvola passa
in Posizione B

(Figura 1-10), il campione viene iniettato.

Figura 1-9 Valvola deviatrice—modalita iniettore posizione A

Elemento | Descrizione

Ingresso campione

Uscita rifiuti

Loop del campione

Ingresso fase mobile

al bl WO N —~

Alla colonna
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Figura 1-10 Valvola deviatrice—modalita iniettore posizione B

Elemento | Ingresso campione
1 Ingresso campione
2 Uscita rifiuti
3 Loop del campione
4 Ingresso fase mobile
5 Alla colonna
Guida per I'Utente Strumenti AB SCIEX Serie 6500

29 di 132



Informazioni sul Sistema

Collegare la Valvola Deviatrice in Modalita Deviatore

Figura 1-11

Valvola deviatrice—modalita deviatore posizione A

Elemento

Descrizione

1

Allo spettrometro di massa

2

Dalla colonna

3

Uscita rifiuti
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Figura 1-12 Valvola deviatrice—modalita deviatore posizione B

Elemento | Ingresso campione
1 Allo spettrometro di massa
2 Dalla colonna
3 Uscita rifiuti

Fluidi Approvati per il Sistema

| seguenti fluidi possono essere impiegati in sicurezza nel sistema:
*  Metanolo per LC/MS (da 0 a 100%)
*  Acetonitrile per LC/MS (da 0 a 100%)
* Acqua per HPLC
* Acido formico per LC/MS (da 0 a 1%)
* Acetato d'ammonio (da 0 a 1%)

“w«s  Nota: Questo elenco non & completo. Non utilizzare nessun altro fluido prima di aver
ricevuto conferma da AB SCIEX che il suo utilizzo non comporti alcun rischio.

/4
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Profili Hardware

Un profilo hardware comunica al software quali strumenti e dispositivi bisogna utilizzare e come
gli strumenti e i dispositivi sono configurati e connessi al computer.

Ogni profilo hardware deve includere uno spettrometro di massa. Prima di creare un metodo di
acquisizione, assicurarsi che tutti i dispositivi usati nel metodo siano inclusi nel profilo hardware.
Nelle opzioni di configurazione per lo spettrometro di massa, assicurarsi che la pompa a siringa
sia abilitata se dovra essere usata durante I'acquisizione.

| dispositivi configurati nel profilo hardware attivo e selezionati nella finestra di dialogo Add/
Remove Device Method compaiono come icone nel riquadro Acquisition Method Browser. Solo i
dispositivi inclusi nel profilo hardware attivo possono essere usati per creare metodi di
acquisizione.

Per maggiori informazioni sulla configurazione dei dispositivi, fare riferimento alla Guida alla
Configurazione delle Periferiche. Per un elenco dei dispositivi supportati, fare riferimento alla
Guida all'Installazione del Software per il software Analyst®.

Creare un Profilo Hardware

L'utente pud creare diversi profili hardware, ma solo un profilo alla volta pud essere attivo. Gli
utenti possono specificare nel profilo hardware il range di massa all'interno del quale gli strumenti
della serie 6500 dovranno operare.

1. Nella Barra di Navigazione, alla voce Configure, fare doppio clic su Hardware
Configuration.
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Heardware Prafilz=:

Hardware Configuration Editor E |

Mawe Profile. . I
Edit Frifile.. |
Activals Frofls |
Lreailable Davicas |
Clos= I

Help |

Figura 2-1 Finestra di dialogo Hardware Configuration Editor

2. Nella finestra di dialogo Hardware Configuration Editor, fare clic su New Profile.

Prafile: N arne: ||

Devices in current profile;

] 6

Add Device...

[Nelete Meyize

Setup Device,..

Cancel

LI

Create New Hardware Profile Ed |

Figura 2-2 Creare un Nuovo Profilo Hardware
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3. Scrivere il nome del profilo nel campoProfile Name.
Fare clic su Add Device.

Nella finestra di dialogo Available Devices, selezionare il dispositivo nell'elenco
Device Type. |l valore preimpostato € Mass Spectrometer.

Available Devices E|
Device Type:
Mass Spectiometer
Devices:
b azz Spectrometer AP 300 ~

b azz Spectrometer AP 365

b azz Spectrometer AP 2000

b azz Spectrometer AP 3000

b azz Spectrometer AP 4000

b azz Spectrometer ATrap

b azz Spectrometer 4000 0 TRAP

b azz Spectrometer AP 3200

b azz Spectrometer 3200 0 TRAP

b azz Spectrometer AP 5000

b azz Spectrometer Triple Quad 5500
b azz Spectrometer ATRAF 5500

b azz Spectrometer Triple Quad 6500
b azz Spectrometer ATRAF 6500

[ OF. ] [ Caticel

Figura 2-3 Finestra di dialogo Available Devices

5. Selezionare uno strumento nell'elenco Devices .
6. Fare clic su OK.
7. Selezionare lo strumento nell'elenco Devices in current profile.
8. Fare clic su Setup Device.
Si aprira la finestra di dialogo Mass Spectrometer.
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Mass Spectrometer g]

Configuration | Cammunication

Alias:

Synchronization Trigger
() Active low
() Active high

Mote: Scanning will be triggered by 2 0% zignal if the
Active Low synchronization trigger is selected.

Settings for Integrated Devices
[ Use integrated injector/diverter valve

[JUse integrated syringe pump

DuaSpray lon Source Switching Walve Counter

Dual Mazs Mode
(%) Low Maszs
() High Mass
[ QK ] l Cancel l [ Help ]

9. Nella scheda Configuration, alla sezione Dual Mass Mode, selezionare una delle
due opzioni seguenti:

* Low Mass: Selezionare questa opzione per operare in un range di massa
limitato, in una modalita operativa che assicuri un'alta sensibilita. Il range di
massa va da 5 a 1000 Da per le scansioni LIT (trappola lineare ionica) e da 50
a 1250 Da per le scansioni quadrupolari.

* High Mass: Selezionare questa opzione per operare in un range di massa piu
esteso. Il range di massa va da 5 a 2000 Da per le scansioni LIT e da 50 a
2000 Da per le scansioni quadrupolari.

10. Selezionare altre opzioni nelle schede Configuration e Communication come
richiesto.

11. Fare clic su OK per ritornare alla finestra di dialogo Create New Hardware Profile.
12. Fare clic su Add Device.

13. Aggiungere e configurare ogni dispositivo che sara usato con lo strumento. Fare
riferimento a Aggiungere Dispositivi a un Profilo Hardware a pagina 37.

14. Nella finestra di dialogo Create New Hardware Profile, fare clic su OK.

15. Nella finestra di dialogo Hardware Configuration Editor, fare clic sul profilo
hardware.

16. Fare clic su Activate Profile.
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Il segno di spunta diventa verde. Se appare una x rossa, si € verificato un problema
con l'attivazione del profilo hardware. Fare riferimento a Risoluzione dei Problemi -
Attivazione Profilo Hardware.

~ Suggerimento!Un profilo hardware non deve essere disattivato prima di
/  attivarne un altro. Fare clic su un profilo hardware e poi su Activate
(= Profile. L'altro profilo sara automaticamente disattivato.

17. Fare clic su Close.

Aggiungere Dispositivi a un Profilo Hardware

| dispositivi devono essere configurati per far si che il software possa comunicare con loro.

Quando si installa il software, si installano anche i driver necessari per ogni dispositivo. Dopo che
i dispositivi sono stati connessi fisicamente al computer, configurare ogni dispositivo.

1. Aprire Hardware Configuration Editor.

Nell'elenco Hardware Profiles, disattivare il profilo hardware.
Fare clic su Edit Profile.

Fare clic su Add Device.

o 0D

Nella finestra di dialogo Available Devices, selezionare il dispositivo nell'elenco
Device Type .

6. Fare clic su OK.

Device Type:

I tazs Spectrometer j

Purnp

Autozampler

Colurnn Owven

Y alve

Detector

A0 Corveerter
|nteqrated System

S oftware Application

Figura 2-4 Finestra di dialogo Available Devices
Selezionare lo strumento nell'elenco Devices in current profile.
Fare clic su Setup Device.

Si aprira una finestra di dialogo che contiene i valori di configurazione per il
dispositivo.

9. Nella scheda Communication, nel campo Alias, immettere un nome o un altro
identificativo. (Opzionale)
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““s Nota: Peridispositivi che utilizzano la comunicazione seriale, assicurarsi

] che la porta seriale selezionata corrisponda alla porta seriale a cui il
dispositivo € fisicamente collegato. Se si utilizza un cavo di espansione

seriale, il numero selezionato nel profilo € il numero sul cavo piu due.

““s Nota: |l campo Alias pud anche essere denominato Name e pud essere
/ trovato su un'altra scheda alla voce Alias.

» Se il dispositivo utilizza la Porta Seriale come interfaccia di comunicazione,
selezionare la porta COM alla quale il dispositivo & collegato nell'elenco COM
Port Number.

» Se il dispositivo utilizza la Ethernet come interfaccia di comunicazione,
digitare l'indirizzo IP assegnato dall'amministratore al dispositivo o utilizzare il
nome host corrispondente all'indirizzo.

» Se il dispositivo utilizza una scheda GPIB come interfaccia di comunicazione,
non modificare le impostazioni per la scheda GPIB.

Il resto dei valori preimpostati per il dispositivo sono probabilmente adeguati; non
modificarli. Per informazioni sulle schede Configuration e Communication, fare
riferimento al menu Help.

10. Per ripristinare i valori preimpostati dei dispositivi, fare clic su Set Defaults nella
scheda Communication.

11. Per salvare la configurazione fare clic su OK.
12. Ripetere i passi da 4 a 9 per ogni dispositivo.
13. Nella finestra di dialogo Create New Hardware Profile, fare clic su OK.

14. Per attivare il profilo hardware, fare clic sul profilo in Hardware Configuration
Editor.

15. Fare clic su Activate Profile.

Il segno di spunta diventa verde. Se appare una x rossa, si € verificato un problema
con l'attivazione del profilo hardware. Fare riferimento a Risoluzione dei Problemi -
Attivazione Profilo Hardware.

~  Suggerimento!Un profilo hardware non necessita di essere disattivato
/ prima di attivarne un altro. Fare clic su un profilo hardware e poi su
> Activate Profile. L'altro profilo sara automaticamente disattivato.

16. Fare clic su Close.

Risoluzione dei Problemi - Attivazione Profilo
Hardware

Se non si riesce ad attivare un profilo hardware, apparira una finestra di dialogo che indica quale
dispositivo nel profilo presenta dei problemi. La mancata riuscita potrebbe essere dovuta a errori
nella comunicazione.
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1. Leggere il messaggio d'errore generato. In base alla natura del messaggio, potrebbe
esserci un problema con un dispositivo 0 nella comunicazione.

Verificare che il dispositivo sia alimentato e sia acceso.
Verificare che la porta COM assegnata al dispositivo sia corretta.

seriale sulla scheda di espansione & di solito COM3, anche se il cavo indica

< Suggerimento!Sui computer con due porte seriali integrate, la prima porta
v
=~ Pl

4. Verificare che le impostazioni di comunicazione con il dispositivo (ad esempio, le
impostazioni del DIP switch) siano impostate correttamente e corrispondano alle
impostazioni della scheda Communication.

Spegnere il dispositivo.
Attendere 10 secondi
Accendere il dispositivo.

Attendere fino a quando tutte le attivita di avviamento del dispositivo siano state
completate prima di tentare nuovamente I'attivazione del profilo hardware. Alcuni
dispositivi possono richiedere 30 secondi o piu per completare I'avviamento.

8. Attivare il profilo hardware.
9. Se il problema persiste, eliminare il profilo non funzionante e crearne uno nuovo.
10. Se il problema persiste, contattare I'assistenza tecnica.

Creare Progetti e Sottoprogetti

Per creare una struttura a sottoprogetti all'interno di un progetto, definire la struttura a
sottoprogetti nel momento in cui si crea il progetto.

1. Fare clic su Tools > Project > Create Project.
2. Scrivere il nome del progetto nel campoProject name.

3. (Opzionale) Per usare i sottoprogetti, selezionare le cartelle in questione e poi usare
i tasti freccia per spostarli nell'elenco Subproject folders.
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Create New Froject/Subproject E

Froject vall be created undes the following directone

Praject name

—Suboroject Spedificaion:

Subproject name:
N

Praject faldzrs: Subproject folders:

Acaazbon Methods -
Aeguizibion S oipte

Batch =
Bindnalyst
Data

Log — <=
Proceszing Methads

Procezshg Sonipks j

L PP o P B 'O 1 P

Add Al Remave Al |

I Set configuration as default o rew proiects

o | Cared | Halp |

Figura 2-5 Finestra di dialogo Create new Project/Subproject

4. (se siusano i sottoprogetti.) Nel campo Subproject name, immettere un nome per il
primo sottoprogetto o usare la data gia impostata.

5. Per impostare questa organizzazione in progetti e sottoprogetti come base per tutti i
nuovi progetti, spuntare la casella Set configuration as default for new projects.

Tutti i nuovi progetti saranno creati con le cartelle configurate in questo modo.
6. Fare clic su OK.

Creare un Sottoprogetto

| sottoprogetti possono essere creati solo in un progetto che & stato gia impostato per contenere
sottoprogetti.

1. Selezionare il progetto nell'elencoProject presente sulla barra Project.
2. Fare clic su Tools > Project > Create Subproject.

3. Nella casella Subproject name, immettere un nome per il sottoprogetto o usare la
data preimpostata.

4. Fare clic su OK.
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Copiare un Sottoprogetto

L'utente pud copiare un sottoprogetto da un altro progetto che ha sottoprogetti gia salvati. Se i
sottoprogetti copiati contengono cartelle che esistono anche nella cartella del progetto, il
software usera le cartelle al livello del progetto.

Fare clic su Tools > Project > Copy Subproject.

N

Nella finestra di dialogo Copy Subproject, fare clic su Browse per navigare nella
cartella sorgente del sottoprogetto.

Fare clic su OK.

Selezionare il sottoprogetto nell'elenco Source Subproject .

Fare clic su Browse per navigare nella cartella di destinazione del sottoprogetto.
Scrivere il nome nel campo Target Subproject.

Fare clic su OK.

© N o o bk w

Compiere una delle seguenti operazioni:

» Per copiare tutte le cartelle e i file dallaSubproject Source nella Subproject
Destination, spuntare la casella Copy Contents.

» Per copiare solo la struttura delle cartelle e non il contenuto nella cartella
Subproject Destination, assicurarsi che la casella Copy Contents non sia
spuntata.

9. Fare clic su Copy.

Cartelle di Progetto Installate

Il software installera tre cartelle di progetto: API Instrument, Default, ed Example.

Cartella API Instrument

La cartella API Instrument folder € una cartella unica ed &€ molto importante per il corretto
funzionamento dello strumento. La cartella API Instrument contiene le informazioni richieste per
sintonizzare e calibrare lo strumento. Queste informazioni comprendono i file di impostazioni dei
parametri, i file di riferimento, i file di dati dello strumento che contengono informazioni sulla
calibrazione e la risoluzione, nonché le modalita di acquisizione utilizzate durante la
sintonizzazione automatica. La cartella API Instrument contiene anche file di dati per le attivita di
sintonizzazione manuale, che sono state eseguite usando il pulsante Start e non il pulsante
Acquire. Questi file di dati sono salvati automaticamente nella cartella API Instrument all'interno
della cartella Tuning Cache e nominati con la data e I'ora in cui sono stati creati. La Tuning
Cache si cancellera automaticamente a intervalli regolari.

Cartella Default

La cartella Default contiene le cartelle che sono presenti nei nuovi progetti e serve come modello
per i nuovi progetti.
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Cartella Example

La cartella Example contiene metodi e file di dati di esempio. Gli utenti possono fare pratica
lavorando in modalita Explore o Quantitate usando i file di dati di esempio. | file di esempio sono
ordinati in sottocartelle per tipo di strumento e area di applicazione.

Backup della Cartella API Instrument

Effettuare regolarmente un backup della cartella API Instrument dopo che si & eseguita una
manutenzione ordinaria.

1.

Copiare la cartella API Instrument, incollarla in una posizione differente,
preferibilmente su un altro computer, e poi rinominare la cartella. Usare come
riferimento la data e il nome dello strumento, se esiste piu di uno strumento, quando
si da il nome alla cartella. Ad esempio: API Instrument_ 4000QTRAP3_010107

Per recuperare la cartella, rinominare la cartella attuale API Instrument, e poi
copiare la cartella di backup nella cartella Projects e rinominarla nuovamente come

APl Instrument.

Tabella 2-1 Icone della Barra degli Strumenti

Icona |Nome Funzione
New Subproject |Crea un sottoprogetto. | sottoprogetti possono essere creati in un

lj secondo momento dell'elaborazione, a condizione che il progetto
sia stato creato in origine con i sottoprogetti.

Copy Subproject | Copia una cartella di sottoprogetto.

[ ]
Si pud copiare un sottoprogetto solo da un altro progetto che ha
sottoprogetti gia salvati. Se la stessa cartella esiste sia al livello
del progetto, sia al livello del sottoprogetto, il software usera la
cartella al livello del progetto.
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Strumento

Eseguire I'opzione Verify Instrument Performance una volta la settimana o dopo che lo strumento
e stato pulito per verificare che il sistema stia funzionando correttamente. In generale, la
calibrazione e la risoluzione per il quadrupolo restano valide per un tempo che va da 3 a 6 mesi,
a meno che il sistema non perda del vuoto. Per i sistemi LIT (trappola ionica lineare), anche la
risoluzione dovrebbe restare valida per un tempo che va da 3 a 6 mesi, ma la calibrazione deve
essere effettuata circa una volta al mese. Se il sistema perde del vuoto, controllare la
calibrazione e la risoluzione prima di usare il sistema. Per maggiori informazioni sulla
sintonizzazione e la calibrazione, fare riferimento alla Guida alle Funzioni Avanzate per I'Utente
e al Tutorial sulla Sintonizzazione Manuale.

Materiale richiesto

»  Soluzioni per la sintonizzazione che sono fornite nel Kit di Prodotti Chimici Standard
consegnati assieme al sistema. Un nuovo Kit puo essere ordinato presso AB SCIEX,
se necessario.

»  Serie di siringhe a tenuta di gas da 5 ml, 1 ml, e 250 pl.
* Tubo di campionamento (rosso) in PEEK.

Prerequisiti

* Assicurarsi che ci sia una stampante configurata.

* Assicurarsi che la nebulizzazione sia stabile e che si stia usando la soluzione per la
sintonizzazione corretta.

Ottimizzare lo Strumento

La seguente procedura illustra come verificare le prestazioni dello strumento. Per ulteriori
informazioni sull'uso delle altre opzioni sulle prestazioni dello strumento, fare riferimento al menu

Help.
1. Nella Barra di Navigazione, alla voce Tune and Calibrate, fare doppio clic su
Manual Tuning.
2. Lanciare un metodo di calibrazione e verificare che il TIC sia stabile e che i picchi
rilevanti siano presenti nello spettro.
3. Nella Barra di Navigazione, alla voce Tune and Calibrate, fare doppio clic su
Instrument Optimization.
Apparira la finestra Instrument Optimization.
Il nome dello strumento e la modalita operativa corrente configurata nel profilo
hardware attivo sono mostrati in fondo alla finestra di dialogo.
4. Fare clic su Verify instrument performance.
Fare clic su Next.
6. Fare clic su Approved Tuning.
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7. Fare clic su Next.
8. Selezionare una soluzione alla voce Tuning Solution.
Sono disponibili diverse modalita in base alla soluzione selezionata.

i. Fare clic su una polarita.

ii. Se sono disponibili, fare clic su Q1 e Q3 alla sezione Quad. Fare clic sulle
velocita di scansione richieste, se disponibili.

iii. Fare clic sulle velocita di scansione alla sezione LIT, se disponibili.
iv. Fare clic sulle opzioni MS/MS/MS, se disponibili, poi fare clic su Next.

9. Se si aprira la pagina Select a mode, selezionare Automatic e poi fare clic su Next.
10. Fare clic su GO.

Si aprira la schermata Verifying or Adjusting Performance. Dopo che il processo &
stato completato, si aprira la schermata Results Summary. Per ulteriori informazioni,
fare riferimento al menu Help.

11. In base ai campi selezionati, I'utente dovra modificare le soluzioni secondo i vari tipi
di scansione e le polarita.

Verificare o Regolare le Prestazioni

L'angolo in alto a sinistra mostra la parte dello strumento che viene sintonizzata.

Current Spectrum: Questo grafico mostra lo spettro della scansione corrente, la scansione
ottimale scelta dal software, o la scansione al valore corrente del parametro quando i risultati del
software sono visualizzati in modalita interattiva.

La voce Instrument Optimization Decision Plots, nel grafico in alto a destra, mostra
dinamicamente l'intensita rispetto alle curve di tensione dei parametri che sono in corso di
ottimizzazione.

Results Summary

Il Results Summary, mostrato in Figura 3-1, € un registro di tutti i cambiamenti alle impostazioni
dello strumento che sono stati effettuati con il software Instrument Optimization. Comprende la
posizione dei file di dati e il backup delle impostazioni dello strumento, cosi come i cambiamenti
passo-passo e i risultati dell'ottimizzazione. Inoltre il Results Summary mostra un report di
verifica. Questo report contiene un'immagine catturata dello spettro di massa per ogni massa
relativa alle modalita di scansione in corso di verifica. Lo spettro € etichettato con la massa
target, la posizione in cui la massa € stata trovata, lo spostamento della massa, la larghezza e
l'intensita dei picchi. Lo spettro puo essere utilizzato come un registro grafico della forma dei
picchi o delle prestazioni di una determinata modalita di scansione. Una tabella riepilogativa dei
risultati accompagna gli spettri.

Il Results Summary viene salvato come un documento nella cartella indicata nella parte
superiore del report. Gli utenti possono stampare il Results Summary o aprire un Results
Summary salvato in precedenza.
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File Edit View Tools Help

Results Summary

Backing up Instrument Settings to the folder:
Ci\Analyst Data‘\Projects\API Instrument)Data‘\Insatrument Cptimization\2012-5=-28 10.32
Instrument Optimization Ver: 2.5919.9

Q1 Scan Test started. Scan Speed = 200 Da/s
W 0w RS Asanetom Bamci OREOH o T 3wl [ Tarse Sarm)

s
Target Mass: 59.05 Da
: Found At: 59.05 Da
Mass shift: 0.00 Da
Width: 0.87 Da
intensity per Scan:[1.13E+06 cps

-

i

Figura 3-1 Results Summary
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Un metodo di acquisizione &€ composto da esperimenti e periodi. Utilizzare I'Acquisition Method
Editor per creare una sequenza di periodi e di esperimenti per lo strumento e i dispositivi.

Creare Metodi di Acquisizione

Solo i dispositivi configurati nel profilo hardware attivo appaiono nel riquadro Acquisition Method
Browser. Qualsiasi dispositivo aggiunto al profilo hardware deve essere aggiunto anche ai
metodi di acquisizione gia esistenti. Per maggiori informazioni sui dispositivi, fare riferimento alla
Guida alla Configurazione delle Periferiche.

1.

9.

10.
11.
12.

Nella Barra di Navigazione, alla voce Acquire, fare doppio clic su Build Acquisition
Method.

Nella scheda Acquisition Method Properties, selezionare una modalita alla voce
Synchronization Mode.

Spuntare la casella Auto-Equilibration. (Opzionale)

Immettere il tempo di equilibratura desiderato in minuti se é stata selezionata
I'opzione Auto-Equilibration.

Nel riguadro Acquisition method , fare clic sull'icona Mass Spec.
Selezionare il tipo di scansione nella scheda MS.

Immettere i valori nei campi come richiesto. Fare riferimento a Parametri a
pagina 51.

Immettere i valori nei campi come richiesto nella scheda Advanced MS. Fare
riferimento a Parametri a pagina 51.

Fare clic su un'icona dispositivo.

Selezionare i parametri per i dispositivi come richiesto.
Aggiungere altri periodi ed esperimenti, se del caso.
Fare clic su File > Save.

Aggiungere un Esperimento

1.

Fare clic col tasto destro sul periodo e poi fare clic su Add experiment.
Sara aggiunto un esperimento sotto l'ultimo esperimento nel periodo.

Selezionare i parametri appropriati per il dispositivo o lo strumento nel riquadro
Acquisition Method Editor .

Aggiungere un Periodo

Nel riquadro Acquisition method, fare clic sull'icona Mass Spec, poi fare clic su
Add period.

Sara aggiunto un periodo sotto I'ultimo periodo creato.
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Copiare un Esperimento in un Periodo

Prerequisito: Metodo multi-periodo

* Nel riquadroAcquisition method, premere CTRL e poi trascinare l'esperimento nel
periodo.

L'esperimento sara copiato sotto l'ultimo esperimento presente nel periodo.

Copiare un Esperimento contenuto in un Periodo

Seguire questa procedura per aggiungere esperimenti simili o identici a un periodo, se la
maggior parte o tutti i parametri sono identici.

* Fare clic col destro sull'esperimento e poi fare clic su Copy this experiment.

Tecniche di Scansione

MS: Nelle scansioni MS, conosciute anche come scansioni MS singole, gli ioni sono separati
secondo il loro rapporto massa/carica. Una singola scansione MS pud essere utilizzata per
determinare il peso molecolare di un composto. Le scansioni MS singole possono anche essere
indicate come scansioni di indagine. Le scansioni MS non forniscono alcuna informazione circa
la conformazione chimica degli ioni oltre che il rapporto massa/carica. Effettuare scansioni di tipo
MS/MS o MS/MS/MS per ottenere maggiori informazioni sugli ioni.

MS/MS: le scansioni MS/MS sono usate per identificare o verificare una specie molecolare. Nella
MS/MS uno ione precursore puo essere frammentato in una sezione a scelta tra le due
disponibili nello strumento.

* Negli strumenti a triplo quadrupolo la frammentazione avviene nella camera di
collisione.

* Negli strumenti LIT la frammentazione pud avvenire nella camera di collisione o
nella trappola ionica lineare.

Se si impiega abbastanza energia, lo ione precursore si frammenta per generare gli ioni prodotto
caratteristici.

MS/MS/MS: Le scansioni MS/MS/MS degli strumenti LIT rappresentano un passo in avanti
rispetto alle scansioni MS/MS. Un frammento che & prodotto nella camera di collisione &
ulteriormente frammentato nella trappola ionica, in modo da fornire maggiori informazioni
strutturali sullo ione molecolare.

Tipi di Scansione in Modalita Quadrupolo

Gli strumenti a triplo quadrupolo hanno funzionalita MRM (Multiple Reaction Monitoring -
Monitoraggio di Reazioni Multiple) ad alta sensibilita, necessarie per gli esperimenti di
quantificazione. Inoltre hanno tipi di scansione altamente specifici, come le scansioni dello ione
precursore o le scansioni di una perdita di un frammento neutro, che permettono una ricerca piu
avanzata sui componenti dei campioni.

Q1 MS (Q1): Una scansione completa che usa il primo quadrupolo (Q1). L'intensita ionica &
rilevata per ogni massa nel range di scansione.

Q1 Multiple lons (Q1 MI): Un tipo di scansione a larghezza nulla che usa il primo
quadrupolo(Q1). L'intensita ionica € rilevata solo per le masse specificate.
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Q3 MS (Q3): Una scansione completa che usa il terzo quadrupolo (Q3). L'intensita ionica &
rilevata per ogni massa nel range di scansione.

Q3 Multiple lons (Q3 MI): Un tipo di scansione a larghezza nulla che usa il terzo quadrupolo
(Q3). L'intensita ionica é rilevata solo per le masse specificate.

MRM (MRM): Una scansione MS/MS in cui uno ione selezionato dall'utente passa attraverso il
primo quadrupolo (Q1) e viene frammentato nel secondo quadrupolo (Q2). Il terzo quadrupolo
(Q3) ¢ poi utilizzato per determinare quale ione frammento entra nel rivelatore. Questa modalita
di scansione & usata prevalentemente per la quantificazione.

Product lon (MS2): scansione MS/MS completa dove il primo quadrupolo (Q1) & impostato per
trasmettere un determinato ione precursore e il terzo quadrupolo (Q3) effettua una scansione su
un range di massa definito. E usato per identificare tutti i prodotti di un determinato ione
precursore.

Precursor lon (Prec): scansione MS/MS dove il terzo quadrupolo (Q3) & impostato a un
determinato rapporto massal/carica per trasmettere un determinato ione prodotto e il primo
quadrupolo (Q1) scansiona un determinato range di massa. E impiegata per verificare la
presenza di uno ione precursore, o piu comunemente per identificare i composti che condividono
uno stesso ione prodotto.

Neutral Loss (NL): scansione MS/MS , detta anche a perdita neutra, nella quale sia il primo
(Q1), sia il terzo quadrupolo (Q3) effettuano una scansione su un range di massa, mantenendo
una differenza di massa prefissata. Si osserva una risposta se lo ione selezionato dal primo
analizzatore si frammenta perdendo il frammento neutro specificato (la massa prefissata). E
impiegata per verificare la presenza di uno ione precursore, o piu comunemente per identificare i
composti che condividono una perdita neutra comune.

Tipi di Scansione in Modalita LIT

Le scansioni in modalita LIT usano il terzo quadrupolo, Q3, come una trappola ionica lineare. Gli
ioni sono intrappolati e mantenuti nella trappola prima di essere scansionati, garantendo di
conseguenza una sensibilita piu elevata. Inoltre nella trappola ionica lineare si pud eseguire una
MS/MS/MS che fornisce ulteriori informazioni sul campione.

Enhanced MS (EMS): In questa scansione ad alta risoluzione gli ioni sono scansionati nel Q1
fino alla trappola ionica lineare, dove sono poi raccolti. Questi ioni sono poi scansionati dal Q3
per produrre spettri di tipo MS singolo.

Enhanced Multi-Charge (EMC): Questa Questa scansione & simile alla scansione EMS, tranne
per il fatto che prima della scansione degli ioni fuori dalla trappola lineare ionica, c'é€ un periodo di
ritardo in cui gli ioni a bassa carica (principalmente ioni monocarica) sono lasciati uscire in via
preferenziale dalla trappola lineare ionica. Quando gli ioni mantenuti sono scansionati, la
popolazione degli ioni multicarica domina lo spettro risultante.

Enhanced Product lon (EPI): Questo tipo di scansione & usato per ottenere uno spettro MS/MS
di alta qualita su un determinato ione. La frammentazione avviene nella camera di collisione e
quindi fornisce uno spettro MS/MS ricco di informazioni, tipico della frammentazione per
dissociazione attivata da collisione. In questa modalita di scansione lo ione precursore da
frammentare & scelto in precedenza nel Q1 in una finestra di massa ampia da 1 a 4 Da, filtrando
tutti gli altri ioni. Lo ione precursore & frammentato dal gas di dissociazione attivata da collisione
(CAD) nella camera di collisione Q2. Gli ioni frammento generati sono catturati nella trappola
lineare ionica e poi scansionati ad una delle tre velocita di scansione, in funzione della
risoluzione richiesta per lo ione frammento.
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Per gli esperimenti IDA, il campo Product Of &€ impostato a 30 Da di default e questo dato non
dovrebbe essere modificato.

Enhanced Resolution (ER): Questa scansione ad alta risoluzione & simile alla scansione EMS,
eccetto per il fatto che una piccola massa da 30 Da intorno alla massa del precursore &
scansionata fuori dalla trappola ionica lineare alla velocita di scansione piu bassa, per produrre
una finestra ridotta degli spettri a migliore risoluzione.

MS/MS/MS (MS3): In questa modalita di scansione uno ione precursore € selezionato dal Q1 e
frammentato tramite dissociazione attivata da collisione nella camera di collisione Q2. Tutti gli
ioni prodotto risultanti sono trasmessi alla trappola lineare ionica, dove sara isolato un solo ione
prodotto. Lo ione isolato & ulteriormente frammentato nella trappola lineare ionica e gli ioni
prodotto risultanti sono scansionati fuori dalla trappola lineare ionica a una delle tre velocita di
scansione. Come in ogni tecnica basata sulla dissociazione indotta da collisione in una trappola,
c'é un taglio delle masse di valore basso per il secondo passaggio di MS/MS, dovuto al fatto che
gli ioni frammento e precursori con la massa %iu bassa devono essere contemporaneamente
stabili nella trappola. Negli strumenti QTRAP™, questo si traduce nel fatto che si perdono gli ioni
che hanno una massa inferiore al 28 % della massa degli ioni precursori quando si effettuano gl
esperimenti MS3. Questo fenomeno & conosciuto come la regola del "1/3 cut-off" (taglio di un
terzo).

Time Delayed Frag (TDF): Gli ioniprodotto sono generati e raccolti nella trappola lineare ionica.
Durante la prima fase del periodo di raccolta, gli ioni dalla massa piu bassa non sono raccolti
nella trappola lineare ionica. Durante la seconda fase del periodo di raccolta, tutte le masse
comprese nel range di massa definito sono raccolte. Gli spettri ad alta risoluzione degli ioni
prodotto cosi ottenuti sono pitu semplici, se paragonati agli spettri delle scansioni di tipo EPI. La
natura degli spettri aiuta nell'interpretazione della struttura e dei percorsi di frammentazione della
molecola in questione. Questo tipo di scansione non & possibile nei sistemi QTRAP 5500 e
QTRAP 6500.

Note sull’Acquisizione dei Dati Spettrali

| dati spettrali possono essere acquisiti in una delle tre modalita, come mostrato nella tabella di
seguito.

Tabella 4-1 Acquisizione Dati Spettrali

Modalita Descrizione

Profile Il valore preimpostato € 0,1 Da. | dati in modalita Profile sono i dati
generati dallo strumento e corrispondono all'intensita registrata a una
serie di valori di massa distinti e uniformemente distanziati. Ad
esempio, in un range di massa da 100 Da a 200 Da con incrementi di
0,1, lo strumento misurera da 99,95 a 100,05 (registrando 100 come
valore), da 100,05 a 101,15 (registrando 101 come valore)...da
199,95 a 200,05 (registrando 200 come valore).

Peak Hopping Il valore preimpostato € 1,0 Da. Il Peak Hopping € una modalita
operativa di uno spettrometro di massa che prevede l'impostazione di
incrementi piuttosto grandi (approssimativamente 1 Da). Ha il
vantaggio di offrire una maggior velocita (meno iterazioni dei dati), ma
comporta la perdita di informazioni sulla forma dei picchi.
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Tabella 4-1 Acquisizione Dati Spettrali

Modalita

Descrizione

Centroid

Lo strumento scansiona come in modalita Profile, ma crea un
centroide dei dati, sostituendo i picchi trovati con il baricentro pesato
in base all'intensita per ogni picco. | dati basati sul centroide hanno il
vantaggio di ridurre notevolmente la dimensione del file. Lo
svantaggio € che le informazioni sulla forma del picco sono perdute.
Inoltre, se i dati sono stati raccolti usando i centroidi, non possono
essere alterati. E consigliabile usare la modalita Profile e creare un
centroide dei dati dopo I'acquisizione.

Parametri

| parametri di funzionamento sono il set di parametri strumentali attualmente in uso.

Parametri della sorgente e del gas (questi parametri posso variare secondo la
sorgente ionica usata)

Parametri Composto

Parametri Risoluzione

Parametri Rivelatore

Per ulteriori informazioni circa le gamme e i valori dei parametri dello strumento, fare riferimento
a Appendice A: Requisiti e Parametri per gli Strumenti Serie 6500.

La figura in basso mostra la posizione dei parametri sul percorso delle ottiche ioniche.

Figura 4-1 Parametri e percorsi delle ottiche ioniche
Elemento | Parametro Tipo Utilizzo Tipo
Parametro Scansione
1 IS (lon Transfer | Sorgente e Nella sorgente PhotoSpray®, Tutte

Voltage - gas il parametro IS controlla il
Voltaggio voltaggio che trasferisce gl
Trasferimento ioni dalla regione di
loni) ionizzazione primaria verso

I'orifizio del separatore di
interfaccia.

Guida per I'Utente
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Figura 4-1 Parametri e percorsi delle ottiche ioniche (Continua)
Elemento | Parametro Tipo Utilizzo Tipo
Parametro Scansione

1 NC (Needle Sorgente e Il parametro NC controlla la | Tutte
Current - gas corrente applicata all'ago di
Corrente scarica a corona nella sonda
dell'Ago) APCI, usata nella sorgente

Turbo V™. La scarica ionizza
le molecole di solvente, che a
loro volta ionizzano le
molecole del campione.

1 ihe (Interface Sorgente e Il parametro ihe attiva o Tutte
Heater - gas disattiva il funzionamento del
Riscaldatore di riscaldatore di interfaccia.
Interfaccia) Riscaldare l'interfaccia

permette di massimizzare |l
segnale degli ioni e
impedisce la contaminazione
delle ottiche ioniche. Questo
dovrebbe essere sempre
attivato. Il pulsante che
comanda il riscaldatore di
interfaccia indica ON quando
il riscaldatore di interfaccia &
in funzione.

1 IHT (Interface Sorgente e Il parametro IHT controlla la | Tutte
Heater gas temperatura del riscaldatore
Temperature - dell'interfaccia NanoSpray®
Temperatura ed ¢ disponibile solo se la
Riscaldatore di sorgente ionica e l'interfaccia
Interfaccia) NanoSpray sono installate.

1 sdp Sorgente e Il parametro sdp controlla la

gas selezione delle sonde delle

sorgenti ioniche DuoSpray ™:
Sonda TurbolonSpray o
sonda APCI
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Figura 4-1 Parametri e percorsi delle ottiche ioniche (Continua)

Elemento | Parametro Tipo Utilizzo Tipo
Parametro Scansione
1 DP (Declustering | Composto [l parametro DP controlla il Tutte
Potential - voltaggio applicato all'orifizio,
Potenziale di che controlla la capacita di
Declustering) separare i cluster di ioni tra

l'orifizio e lo skimmer (o, nei
sistemi con una Guida lonica
QJet®, tra l'orifizio e la Guida
lonica QJet). E impiegato per
ridurre al minimo i cluster di
solvente che possono restare
sugli ioni campione dopo che
questi entrano nella camera
per vuoto e, se necessario,
per frammentare gli ioni.
Maggiore sara la tensione,
maggiore sara I'energia
impartita agli ioni. Se il
parametro DP & impostato su
valori troppo alti, potrebbe
avvenire una frammentazione
indesiderata.

Usare il valore preimpostato e
ottimizzarlo per il composto.

1 CUR (Curtain Sorgente e Il parametro CUR controlla il | Tutte
Gas) gas flusso di gas nell'interfaccia
del Curtain Gas™.
L'interfaccia del Curtain Gas
€ posizionata tra il separatore
di interfaccia e l'orifizio.
Favorisce I'evaporazione del
solvente e impedisce I'entrata
di goccioline di solvente che
potrebbero contaminare le
ottiche ioniche. Il flusso del
gas dovrebbe essere
mantenuto piu alto possibile
senza che ne risenta la
sensibilita.
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Figura 4-1

Parametri e percorsi delle ottiche ioniche (Continua)

Elemento

Parametro

Tipo
Parametro

Utilizzo

Tipo
Scansione

IS (lonSpray
Voltage -
Voltaggio
lonSpray)

Sorgente e
gas

Il parametro IS controlla la
tensione applicata
all'elettrodo, che ionizza il
campione nella sorgente
ionica. Esso dipende dalla
polarita e influenza la stabilita
del getto e la sensibilita.
Questo parametro pud
dipendere dal composto e
dovrebbe essere ottimizzato
per ogni composto.

Tutte

GS1 (Gas 1)

Sorgente e
gas

Il parametro GS1 controlla il
gas di nebulizzazione. Il gas
di nebulizzazione aiuta a
generare delle piccole
goccioline dal flusso del
campione e influenza la
stabilita del getto e la
sensibilita.

Tutte

GS2 (Gas 2)

Sorgente e
gas

Il parametro GS2 controlla il
gas ausiliario (o il gas turbo).
E impiegato per favorire
I'evaporazione del solvente e
produrre ioni campione in
fase gassosa.

Tutte

TEM
(Temperatura)

Sorgente e
gas

Il parametro TEM controlla la
temperatura del gas turbo
nella sonda TurbolonSpray®
o la temperatura della sonda
a nebulizzatore riscaldato (o
APCI).

Tutte

EP (Entrance
Potential -
Potenziale in
Entrata)

Composto

Il parametro EP controlla la
differenza di potenziale tra il
voltaggio sul QO e la terra. |l
potenziale in entrata guida e
focalizza gli ioni attraverso la
regione ad alta pressione del
QO.

Usare il valore preimpostato.

Tutte
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Figura 4-1

Parametri e percorsi delle ottiche ioniche (Continua)

Elemento

Parametro

Tipo
Parametro

Utilizzo

Tipo
Scansione

QO Trapping
(Intrappolamento
QO0)

Composto

[l parametro QO trapping
controlla il mantenimento
degli ioni nella regione del
QO. E impiegato per
aumentare la sensibilita e il
ciclo di lavoro, intrappolando
gli ioni nella regione del Q0
mentre gli ioni sono
selezionati in base alla
massa ed espulsi dalla
trappola lineare ionica. Usare
un tempo di riempimento
prefissato per questo
parametro.

Selezionare o disabilitare
questa opzione in base
all'esperimento.

Il tempo di riempimento
prefissato (Fixed Fill Time) da
usare con il QO trapping & 20
ms 0 maggiore.

EMS, EMC,
EPI, ER, e MS/
MS/MS,

CAD Gas

Sorgente e
gas

Il parametro CAD controlla la
pressione del gas di
collisione nella camera di
collisione durante le
scansioni Q3, LIT e MS/MS.
Nelle scansioni Q3 il gas di
collisione aiuta a focalizzare
gli ioni mentre passano
attraverso la camera di
collisione; il parametro CAD &
preimpostato in modalita
fissa. Nelle scansioni MS/MS
il gas di collisione aiuta a
frammentare gli ioni
precursori. Quando gli ioni
precursori collidono con il gas
di collisione, possono
dissociarsi e formare ioni
prodotto. Nelle scansioni LIT
il gas di collisione aiuta a
focalizzare e intrappolare gli
ioni nella trappola lineare
ionica.

Usare il valore preimpostato e
ottimizzarlo per il composto.

Q3 MI, Q3 MS,
MRM, Prec,
NL, EMS, ER,
EPI,
MS/MS/MS,
EMC, e TDF
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Figura 4-1 Parametri e percorsi delle ottiche ioniche (Continua)
Elemento | Parametro Tipo Utilizzo Tipo
Parametro Scansione

3 CE (Collision Composto Il parametro CE controlla la MRM, MS2,
Energy - Energia differenza di potenziale tra il | Prec, NL, e LIT
di Collisione) QO e il Q2 (camera di

collisione). E usato solo nelle
scansioni di tipo MS/MS.
Questa & la quantita di
energia che gli ioni precursori
ricevono quando sono
accelerati nella camera di
collisione, dove collidono con
le molecole digas e i
frammenti.

Usare il valore preimpostato e
ottimizzarlo per il composto.

3 CES (Collision Composto Il parametro CES, in EPl e
Energy Spread - combinazione con la Collision | MS/MS/MS
Estensione Energy (CE), determina quali
dell’Energia di sono le tre distinte energie di
Collisione ) collisione da applicare alla

massa del precursore in un
esperimento Enhanced
Product lon (EPI) o MS/MS/
MS (MS3) quando il
parametro & attivato. Il CES
é attivato automaticamente
quando viene immesso un
valore per l'estensione
dell'energia di collisione.
Usare il valore preimpostato e
ottimizzarlo per il composto.

4 CXP (Collision Composto Il parametro CXP & impiegato | Q3, MRM,
Cell Exit Potential solo nelle scansioni Q3 e MS/ | MS2, Prec, e
- Potenziale in MS, dove trasmette gli ioni al | NL
Uscita dalla Q3.
ggm:i?ng; Usare il valore preimpostato e

ottimizzarlo per il composto.

4 TDF CE (Time Composto Questa € la quantita di TDF
Delayed energia ricevuta dagli ioni
Fragmentation precursori quando vengono
Collision Energy - accelerati nel Q3, dove
Energia di collidono con le molecole del
Collisione per gas e i frammenti.

Eli'?arpdrgfar;tazmne Usare il valore preimpostato.
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Figura 4-1 Parametri e percorsi delle ottiche ioniche (Continua)
Elemento | Parametro Tipo Utilizzo Tipo
Parametro Scansione

5 Q3 Entry Barrier | Composto Il parametro Q3 Entry Barrier | EMS, EMC,
(Barriera in e usato per trasferire gli ioni | EPI, ER, e MS/
Ingresso Q3) dal Q2 alla trappola lineare MS/MS

ionica.
Usare il valore preimpostato.

5 Q3 Empty Time | Composto Il parametro Q3 Empty Time |EMC
(Tempo di controlla Il'intervallo di tempo
rimozione Q3) durante il quale gli ioni

monocarica sono rimossi
dalla trappola lineare ionica.
Usare il valore preimpostato.
MS/MS/MS Composto Il parametro MS/MS/MS MS/MS/MS
Fragmentation Fragmentation Time controlla
Time (Tempo di l'intervallo di tempo in cui si
Frammentazione) applica l'energia di
eccitazione. E impiegato in
combinazione con I'energia di
eccitazione (AF2) per
frammentare lo ione
precursore secondario
isolato.
Usare il valore preimpostato.

6 MCS Barrier Composto Il parametro MCS Barrier EMC
(Multi-Charge controlla il voltaggio applicato
Separation - guando si eliminano gli ioni
Barriera di monocarica dalla trappola
Separazione lineare ionica.

Multicarica) Usare il valore preimpostato.

6 Q3 Cool Time Composto Il parametro Q3 Cool Time TDF
(Tempo di controlla l'intervallo di tempo
Raffreddamento concesso agli ioni precursori
Q3) per raffreddarsi prima della

raccolta dei loro ioni prodotto.
Usare il valore preimpostato.

7 Fixed LIT Fill Composto Il parametro Fixed LIT Fill EMS, EPI,
Time (Tempo di Time controlla l'intervallo di MRM, e MS/
riempimento fisso tempo durante il quale la MS/MS

LIT)

trappola lineare ionica &
riempita dagli ioni.

Usare il valore preimpostato.
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Figura 4-1

Parametri e percorsi delle ottiche ioniche (Continua)

Elemento

Parametro

Tipo
Parametro

Utilizzo

Tipo
Scansione

DFT (Dynamic
Fill Time -
(Tempo di
Riempimento
Dinamico)

Composto

Il DFT calcola in maniera
dinamica l'intervallo di tempo
nel quale gli ioni saranno
raccolti nella trappola lineare
ionica sulla base del segnale
degli ioni in ingresso. Quando
il DFT é attivato, il segnale
ionico & ottimizzato per
incrementare la sensibilita o
minimizzare gli effetti di
carica spaziale (space-
charging).

Selezionare o disabilitare
questa opzione in base
all'esperimento.

Nella finestra di dialogo Tools
> Settings > Method
Options, le impostazioni del
Dynamic Fill Time sono
ottimizzate per una velocita di
scansione di 10.000 Da/s.
Queste impostazioni sono
adatte anche per altre
velocita di scansione LIT.

EMS, EPI, ER,
e
MS/MS/MS

EX2

Rivelatore

La seconda lente di uscita
(EX2) scherma la trappola
lineare ionica dall'alta
tensione presente nel
rivelatore. Il parametro EX2
controlla il voltaggio applicato
alla trappola lineare ionica.
Questo parametro non
necessita di essere
ottimizzato, ed & impostato di
default su un valore fisso che
non e visualizzato
nell'interfaccia del software
Analyst.

Q1, Q3, MS/
MS, LIT

CEM (CEM)

Rivelatore

Il parametro CEM controlla il
voltaggio applicato al
rivelatore. Il voltaggio
controlla la risposta del
rivelatore.

Tutte
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Icone Acquisition Method Editor

Tabella 4-2 Icone Acquisition Method Editor

Icona |Nome Funzione
Mass Spec Mostra la scheda MS nel Acquisition Method
Editor
Period Fare clic col destro per aggiungere un

esperimento, aggiungere un IDA Criteria Level o
cancellare il periodo.

Autosampler

Apre la scheda Autosampler Properties per
I'autocampionatore.

i = o G

Syringe Pump

Apre la scheda Syringe Pump Properties per la
pompa a siringa.

-
-
-

Column Oven

Apre la scheda Column Oven Properties per il
forno della colonna.

’ Valve Apre la scheda Valve Properties per la valvola.

Uy DAD Apre la scheda DAD Method Editor. Per

' nl maggiori informazioni sul DAD, fare riferimento a
Mostrare i Dati DAD a pagina 84.

~._ |ADC Apre la scheda ADC Properties. Per maggior

[] | informazioni sull'ADC, fare riferimento a Show

ADC Data a pagina 78.
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AB SCIEX
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Un batch & una collezione di informazioni riguardanti i campioni. | batch comunicano al software
I'ordine secondo il quale i campioni devono essere analizzati. Per ulteriori informazioni
sull'importazione dei batch, fare riferimento alla Guida alle Funzioni Avanzate per I'Utente.

Impostare le Opzioni della Coda

La coda (Queue) procede lungo I'elenco dei campioni, eseguendoli uno a uno con il metodo di
acquisizione selezionato. Dopo che tutti i campioni sono stati acquisti, la coda si interrompe e lo
strumento entra in modalita Standby. In modalita Standby le pompe LC sono spente e
I'erogazione di corrente ad alcuni strumenti & sospesa.

L'utente pud modificare la durata del tempo massimo di attivita della coda dopo che l'ultima
acquisizione é stata terminata, prima che lo strumento passi alla modalita Standby. Per maggiori
informazioni sugli altri campi della finestra di dialogo Queue Options, fare riferimento al menu
Help.

1. Nella Barra di Navigazione, fare clic su Configure.
2. Fare clic su Tools > Settings > Queue Options.

e N |

Max Mum. % aiting Samples [ 00

Max Mum. Acguired Samples |25

1T

Max Idle Time 5l ity
fdax Tune ldle Time =1l riiik
Disk Space Threshald 100 MButes
Leave Mazs Spec onin Standbp [

Fail whale batch in caze af mizzing visl [

Uz flat hle=s o szan data [

ak | Cancel | Helo |

Figura 5-1 Finestra di dialogo Queue Options

3. Nel campo Max Idle Time, immettere il tempo massimo durante il quale la coda sara
posta in attesa dopo che I'ultima acquisizione sara stata completata, prima di
passare in modalita Standby. Il valore preimpostato € 60 minuti.

4. Se siusano le bombole per il gas, regolare questa durata per assicurarsi che il gas
delle bombole non si esaurisca.
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5. Se si usa un metodo LC, allora prima dell'esecuzione bisogna assicurarsi che ci sia
abbastanza solvente nei serbatoi, in base alla la velocita di flusso primaria, per tutte
le acquisizioni in coda e per il tempo massimo di inattivita.

Creare e Inviare un Batch

Per maggiori informazioni sull'aggiunta di informazioni quantitative a un batch, fare riferimento
alla Guida alle Funzioni Avanzate per I'Utente.

1. Nella Barra di Navigazione, alla voce Acquire, fare doppio clic su Build Acquisition
Batch.

Sample | Locations | Quantitation | Submt |

Select Method for Sample Set
Quanfitation
Set [SET o =l nmum|
Agd Sel ;
| | =[5z s Tenmize [ none =] uwsa~|
| I I Use 1utie e
BalchScrpt: | sms;npa|

| Sample Hame|Rack Code| Rack Position| Plate Code|Plate Position| Vial Position| DataFile |

Figura 5-2 Batch Editor
2. Nella scheda Sample, nell'elenco Set, immettere un nome.
3. Fare clic su Add Set.
4. Fare clic su Add Samples.
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Add sample | %] |
— Gample name

Prafix: Im Sample Fumbar:
Mumber af digits: |3

Daafile

Prefis: I[jaa Sefpame ¥
Auto Imerament: [

Cub Folder: I Browze |

— Mew zarmple

Murber: I-I
ok | cence | Hep

Figura 5-3 Finestra di dialogo Add Sample
Alla sezione Sample name, nel campo Prefix, immettere un nome per i campioni.

6. Per aggiungere una numerazione progressiva al termine del nome del campione,
spuntare la casella Sample number.

7. Se la casella Sample number & spuntata, immettere il numero di cifre da includere
nel nome del campione nel campo Number of digits.

Ad esempio, se si immette 3, i nomi dei campioni saranno nomedelcampione001,
nomedelcampione002 e nomedelcampione003.

8. Alla sezione Data file , nel campo Prefix, immettere un nome per il file di dati che
archiviera le informazioni sul campione.

9. Spuntare la casella Set name per usare il nome del set come parte del nome del file
di dati.

10. Spuntare la casella Auto Increment per impostare la numerazione progressiva
automatica dei nomi dei file di dati.

“w«s Nota: | dati per ogni campione possono essere archiviati nello stesso file
/ o in un file di dati separato. | nomi dei file di dati avranno suffissi numerici
% con 1 come valore di partenza.

11. Immettere un nome nel campo Sub Folder.

La cartella sara archiviata nella cartella Data del progetto corrente. Se il campo Sub
Folder ¢ lasciato vuoto, il file di dati sara archiviato nella cartella Data e non sara
creata alcuna cartella.

12. Alla sezione New samples, nel campo Number, immettere il numero dei nuovi
campioni.

13. Fare clic su OK.
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La tabella dei campioni sara compilata con i nomi dei campioni e i nomi dei file di
dati.

. Suggerimento! Le opzioniFill Down e Auto Increment sono disponibili nel
./ menu attivato col tasto destro, dopo che & stata selezionata l'intestazione di
(= una colonna o diverse righe in una colonna.

14. Nella scheda Sample, alla sezione Acquisition, selezionare un metodo dall'elenco.

Si dovranno inserire informazioni specifiche sull'autocampionatore, se questo &
incluso nella configurazione del sistema. Anche se il volume dell'iniezione &
impostato nel metodo, questo pud essere modificato per uno o piu campioni
modificando il valore nella colonna Injection Volume.

/questo set, spuntare la casella Use Multiple Methods. La colonna
2 Acquisition Method & mostrata nella tabella Sample. Selezionare il metodo
di acquisizione per ciascun campione in questa colonna.

< Suggerimento!Per usare metodi diversi per alcuni dei campioni presenti in
/

15. Per modificare i volumi delle iniezioni rispetto a quelli elencati nel metodo nella
colonna Inj. Volume (L), immettere il volume dell'iniezione per ogni campione.

16. Per impostare le posizioni dei campioni, seguire una delle procedure in basso:

* Impostare la Posizione dei Campioni nel Batch Editor. a pagina 65

» Selezionare le Posizioni delle Vial tramite la Scheda Locations a pagina 66
17. Fare clic sulla scheda Submit.

18. Se la sezione Submit Status contiene un messaggio sullo stato del batch, compiere
una tra le seguenti operazioni:

+ Se il messaggio indica che il batch & pronto per l'invio, saltare al passo 19.

» Se il messaggio indica che il batch non & pronto per l'invio, apportare le
modifiche come indicato nel messaggio.

19. Fare clic su Submit.

Modificare I'Ordine dei Campioni

L'ordine dei campioni pud essere modificato prima che gli stessi siano inviati in Coda.

* Nella scheda Submit, fare doppio clic su uno dei numeri all'estrema sinistra della
tabella (sara visualizzata una casella trasparente) e poi trascinarli fino alla nuova
posizione.

Acquisizione Dati

Il sistema non dovrebbe essere in modalita Tune quando si avvia l'acquisizione dei campioni.
Inoltre, se il sistema & stato gia avviato durante la giornata e non & stato ancora impostato su
Standby, I'acquisizione dei campioni iniziera automaticamente.

1. Nella Barra di Navigazione, fare clic su Acquire.
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2. Fare clic su View > Sample Queue.
Si aprira il Queue Manager con tutti i campioni inviati.

Ty “,:-.:quire Hode -] ||f| I [Example | __i. ® =M ‘E |
BEGB-=wT % |
nmming/siM.J__ ol [0 Peind[0 of [T D [Mmi0 @DWWSW“E
oz w 100 Elepe=d ISI.and By Mairal
start Time sample Name  |Plate Po [wial  [status  |Matho/ | Batcy [
1 E 200712/04 10:56:03 | Sam pleddd 0 D Waiting 2 tutorial Z+# Batth Da.
2 E (20074204 11:02:04 | Sam ple002 i} i} Waiting £ _tutorial 3 Bateh Dian
3 E 200712104 11:08:05 [ Sam pledd3 0 D Waiting |GIHE_1J.|tE-|iGI STaw Balch Da
Figura 5-4 Queue Manager
Elemento | Descrizione
1 L'icona Tune non deve essere premuta.
2 Stato della coda.
3 Il Queue Server deve essere in modalita Normal. Fare
riferimento a Stati della Coda a pagina 70.

3. Fare clic su Acquire > Start Sample.

Impostare la Posizione dei Campioni nel Batch
Editor.

Se si usa un autocampionatore nel metodo di acquisizione, allora la posizione delle vial dei
campioni deve essere definita nel batch di acquisizione. Definire la posizione nella scheda
Sample o nella scheda Locations. Per maggiori informazioni sulla creazione dei batch, fare
riferimento a Creare e Inviare un Batch a pagina 62.

necessario immettere ulteriori dettagli nelle colonne aggiuntive.

S

} Nota: In base al tipo di autocampionatore usato, potrebbe non essere

1. Nella finestra di dialogo Sample, nell'elenco Set, selezionare il set.
2. Eseguire le operazioni di seguito, se necessario, per ognuno dei campioni del set:
* Nella colonna Rack Code, selezionare il tipo di rack.

* Nella colonna Rack Position , selezionare la posizione del rack
nell'autocampionatore.

* Nella colonna Plate Code , selezionare il tipo di piatto.
* Nella colonna Plate Position, selezionare la posizione del piatto nel rack.

* Nella colonna Vial Position, immettere la posizione della vial nel piatto o nel
vassoio.

3. Salvare il file.
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Selezionare le Posizioni delle Vial tramite la
Scheda Locations

1. Fare clic sulla scheda Locations del Batch Editor.

Sample Locations | Guantitation | Submit |

MWICTEF‘;\.L 'I Set I :I
B x| &

Ho Rack

Ho Rack

Ho Rack

Ho Rack

Ho Reck

Ha Rack

Selezionare il set nell'elenco Set.
Selezionare I'autocampionatore nell'elenco Autosampler.

Il numero corretto degli spazi del rack per I'autocampionatore € mostrato nella
rappresentazione grafica del rack.

4. Nello spazio associato al rack, fare clic col destro e selezionare il tipo di rack.
| piatti o i vassoi sono mostrati nel rack.

5. Fare doppio clic su uno dei rettangoli.
Appariranno dei cerchi che indicano i pozzetti o le vial per il piatto o il vassoio.

6. Per selezionare se i campioni devono essere marcati per riga o per colonna, fare clic
su Row/Column Selection.

Se il pulsante mostra una linea rossa orizzontale, il Batch Editor marchera i campioni
per riga. Se il pulsante mostra una linea rossa verticale, il Batch Editor marchera i
campioni per colonna.

7. Fare clic sui pozzetti o le vial dei campioni nell'ordine in cui andranno analizzati.
Fare clic nuovamente su un pozzetto o una vial gia selezionati per cancellarli.

8. Salvare il file.
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~\ Suggerimento!Per compilare automaticamente i campioni, tenere
< / premuto il tasto Maiusc e poi fare clic sulla prima e sull'ultima vial all'interno
2 diun set. Per eseguire diverse iniezioni dalla stessa vial, tenere premuto il
tasto Ctrl e poi fare clic sulla posizione della vial. | cerchietti rossi
diventeranno di colore verde.

Guida per I'Utente Strumenti AB SCIEX Serie 6500
67 di 132



Batch

Arrestare I'Acquisizione dei Campioni

Quando si arresta l'acquisizione dei campioni, la scansione in corso verra ultimata e poi si
procedera all'arresto dell'acquisizione.

1. Fare clic sul campione in coda nel Queue Manager successivo al punto in cui
I'acquisizione dovrebbe essere arrestata.

Nella Barra di Navigazione, fare clic su Acquire.

3. Fare clic su Acquire > Stop Sample.

La coda si arrestera dopo che la scansione in corso del campione selezionato sara
stata completata. Lo stato del campione nella finestra Queue Manager (Local)
cambia in Terminated, e tutti gli altri campioni successivi della coda sono messi in

attesa.

4. Per continuare ad elaborare il batch, fare clic su Acquire > Start Sample.

Suggerimenti sui Batch e i Metodi di

Acquisizione

Tabella 5-1 Suggerimenti

Per fare questo...

...fare questo

Per modificare tutti i valori in una
colonna contemporaneamente

fare clic sull'intestazione di una colonna e poi fare clic col
destro. Usare i comandi Auto Increment e Fill Down dal
menu per modificare i valori nella colonna.

Questo funziona anche per piu celle nella stessa colonna.

Per modificare un metodo di
acquisizione esistente

selezionare il metodo dall'elenco e fare clic su Method
Editor. Per creare un nuovo metodo di acquisizione,
selezionare None dall'elenco e fare clic su Method Editor.
Solo gli utenti esperti dovrebbero utilizzare questa
opzione.

Non utilizzare questa opzione se ¢ attiva I'opzione Use
Multiple Methods.

Per applicare un metodo di
quantificazione creato in
precedenza

selezionare il metodo dal menu Quantitation.

Per selezionare piu di un pozzetto o
una vial simultaneamente

tenere premuto il tasto Maiusc e fare clic sul primo e
l'ultimo pozzetto o vial nell'intervallo.
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Batch Editor: Menu Tasto Destro

Fare clic col destro nella tabella Batch Editor per accedere alle seguenti opzioni.

Select Script |

%

Plate Position| Vial Position| Data File

InjVolume (pl)| Standard

Open...
Import From
Save As Batch

1 DataReserpine|5.000

Save Az a Template. ..

3

Hide/Show Calumn.

Save Column Settings. ..

oololololoolololo

Add Custom Column
Delete Custom Column

Fill Down
AutoIncrement

Delete Samples
Other, ..

Select Autosampler

Figura 5-5 Batch: Menu Tasto Destro

Menu Funzione
Open Apre un file di dati.
Import From Importa un file.

Save As Batch

Salva come batch.

Save As a Template

Salva il batch come un modello. Usato con 'opzione Express
View.

Hide/Show Column

Nasconde o mostra una colonna.

Save Column Settings

Salva le impostazioni della colonna del batch.

Add Custom Column

Aggiunge una colonna personalizzata.

Delete Custom Column

Cancella una colonna personalizzata.

Fill Down

Inserisce gli stessi dati nelle celle selezionate.

Auto Increment

Incrementa automaticamente i dati nelle celle selezionate.

Delete Samples

Cancella la riga selezionata.

Select Autosampler

Seleziona un autocampionatore.

Stati della Coda e Stato del Dispositivo

I Queue Manager mostra lo stato della coda, del batch e del campione. Possono essere
visualizzate informazioni piu dettagliate su un determinato campione in coda.

Guida per I'Utente
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Stati della Coda

Lo stato attuale della coda € indicato nel Queue Server.

[ueue Server
£ "2
Ready Harmal
Figura 5-6
[ueue Serser
|§ tl
Ready Tune
Figura 5-7

Indicatore del Queue Server che mostra la modalita Normale

Indicatore del Queue Server che mostra la modalita Tune

La prima icona in Figura 5-6 mostra lo stato della coda. La seconda icona indica se la coda € in
modalita Tune (per la sintonizzazione) o Normal (per I'esecuzione dei campioni). La Tabella 5-2
mostra i vari stati della coda.

Tabella 5-2 Stati della Coda

Icone

Stato

Definizione

[lueue Server

3

Mot Beady

I

M armal

Not Ready

Quando si & in stato di Not Ready, il profilo
hardware & disattivato e la coda non accetta piu
l'invio di altri campioni.

[lueue Serser

©

Stand By

s

M armal

Stand By

Quando si € in stato di Stand By, il profilo hardware
€ stato attivato, ma tutti i dispositivi sono inattivi. Le
pompe non girano e l'erogazione dei gas &
sospesa.

[lueue Server

I i
o

Warming p

a3

M armal

Warming Up

Quando si ¢ in stato di Warming Up, gli strumenti e i
dispositivi sono in fase di equilibratura, le colonne si
stanno condizionando, I'ago del campionatore
viene lavato e i forni della colonna stanno
raggiungendo la temperatura impostata. |l periodo
di equilibratura & selezionato dall'operatore. Da
questo stato il sistema potra passare allo stato
Ready.

[lueue Server

E

Feady

e

M armal

Ready

Quando si ¢ in stato di Ready, il sistema & pronto ad
elaborare i campioni, i dispositivi sono stati
equilibrati e sono pronti all'esecuzione. In questo
stato la coda puo ricevere campioni e sara messa in
esecuzione dopo che i campioni saranno stati
inviati.

[Queue Server

3

W aiting

s

MHarmal

Waiting

Quando si & in stato di Waiting, il sistema iniziera
automaticamente l'acquisizione quando si inviera il
campione successivo.
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Tabella 5-2 Stati della Coda (Continua)

Icone Stato Definizione
ThELE S Prerun Quando si & in stato di Prerun, il metodo & in fase di
I £ =3 scaricamento su ciascun dispositivo e I'equilibratura
s - dei dispositivi & in corso. Questo stato sara attivato
(e orma prima dell'acquisizione di ciascun campione in un
batch.
D Ea Acquiring Quando si ¢ in stato di Acquiring, il metodo & in
w3 w3 esecuzione e l'acquisizione dei dati € in corso.
Acquinng Harmal
UNENE S Paused Quando si ¢ in stato di Paused, lo strumento & stato
I‘m =3 messo in pausa durante le acquisizioni.
Fauzed Harmal

Visualizzare le Icone di Stato dello Strumento e dei Dispositivi

Le icone che rappresentano lo strumento e ciascun dispositivo nella configurazione hardware
attiva appaiono sulla barra di stato, all'angolo in basso a destra della finestra. L'utente pud
visualizzare in dettaglio lo stato di una pompa LC e controllare se la pressione della pompa LC
sia appropriata, o visualizzare in dettaglio lo stato dello strumento per controllare la temperatura
della sorgente ionica.

» Fare doppio clic sull'icona del dispositivo o dello strumento nella barra di stato.
Si aprira la finestra di dialogo Instrument Status.

Tabella 5-3 Stati dello Strumento e dei Dispositivi (I'icona mostra lo strumento)

Stato Icon | Colore di Fondo Descrizione
a

Idle Verde o Giallo Il dispositivo non & in funzione. Se il colore di
sfondo é giallo, il dispositivo dovrebbe essere
equilibrato prima di essere pronto
all'esecuzione. Se il colore di sfondo & verde, il
dispositivo & pronto all'esecuzione.

i

i

Equilibrating Verde o Giallo Il dispositivo si sta equilibrando.

=y

i

Waiting Verde Il dispositivo € in attesa di un comando dal
software o da un altro dispositivo, oppure di
un'azione da parte dell'operatore.

=
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Tabella 5-3 Stati dello Strumento e dei Dispositivi (I'icona mostra lo strumento) (Continua)

Stato Icon | Colore di Fondo Descrizione
a
Running Verde Il dispositivo € in esecuzione.
Aborting Verde Il dispositivo sta annullando un'operazione.
Downloading Verde E in corso il trasferimento di un metodo al
? dispositivo.
Ready Verde Il dispositivo non € in esecuzione, ma & pronto
_:? all'esecuzione.
Error Rosso Il dispositivo ha riscontrato un errore che deve
I:ﬂ essere scoperto e corretto.

significa che il dispositivo ha riscontrato un errore mentre era in quello stato.

J Nota: Per ogni stato il colore di fondo pud anche essere rosso. Questa situazione

Queue: Menu Tasto Destro

Fare clic col destro nella tabella Queue per accedere alle seguenti opzioni.

Acquining Sample IEI of ID Period IEI_
0% |
Start Time Sample Name E
1 Z 2008/09/M11 12:18:302ample00
2 % 2008, sample Details 2002
3 g 2008 Reacuire 112003
1 g 2008, Insert Pause je004
5 z 2008 polete 112005
B g 2008 wmove Batch 12006
L g 2008, 007
Sort
a g 2008, e008
g Z 2008, Column Settings 1e009
10 | % |200809TT 10330 [Sample010

Figura 5-8 Queue Manager: Menu Tasto Destro

Menu

Funzione

Sample Details

Apre la finestra di dialogo Sample Details.
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Figura 5-8 Queue Manager: Menu Tasto Destro (Continua)

Menu Funzione

Reacquire Acquisisce nuovamente un campione.

Insert Pause Inserisce una pausa, in secondi, tra due campioni.
Delete Cancella il batch o i campioni selezionati.

Move Batch Sposta i batch nella coda.

Sort Ordina in base alla colonna preselezionata.
Column Settings Modifica le impostazioni della colonna.

Riferimento Rapido Icone: Modalita Acquire

Tabella 5-4 Icone Modalita Acquire

Icona |Nome Funzione

View Queue Mostra la coda dei campioni.

=]

- Instrument Queue Visualizza il terminale di uno strumento remoto.

T Status for Remote Instrument |Visualizza lo stato di uno strumento remoto.

=
Start Sample Avvia il campione in coda.
Stop Sample Ferma il campione in coda.
Abort Sample Arresta I'acquisizione di un determinato campione
durante l'esecuzione.

Stop Queue Ferma la coda prima che abbia terminato di

elaborare tutti i campioni.

Pause Sample Now

Inserisce una pausa nella coda.

Insert Pause before Selected
Sample

Inserisce una pausa prima del campione specificato.

Continue Sample

Continua ad acquisire il campione.

Next Period

Avvia un nuovo periodo.

X = B |(E B (e | [k B

Extend Period

Estende il periodo corrente.

Guida per I'Utente
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Tabella 5-4 Icone Modalita Acquire (Continua)

Icona |Nome Funzione
Next Sample Arresta I'acquisizione in corso del campione e avvia
& I'acquisizione del campione successivo.
Equilibrate Fare clic per selezionare un metodo usato per
¥ equilibrare i dispositivi. Questo metodo dovrebbe
essere lo stesso metodo usato per il primo campione
in coda.
I-‘q Standby Mette lo strumento in modalita Standby.
Ready Mette lo strumento in modalita Ready.
v
Reserve Instrument for Prepara lo strumento per la sintonizzazione e la
T Tuning calibrazione.
Q&: IDA Method Wizard Awvia lo IDA Method Wizard.
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Utilizzare i file di esempio installati nella cartella Example per imparare a visualizzare e
analizzare i dati utilizzando gli strumenti di elaborazione e di analisi piu comuni. Per ulteriori
informazioni su questi argomenti, fare riferimento alla Guida alle Funzioni Avanzate per I'Utente.

Etichettare i grafici

Sovrapposizione e somma degli spettri o dei cromatogrammi
Eseguire sottrazioni dello sfondo

Algoritmi di smussamento

Lavorare con dati smussati

Lavorare con dati calcolati da centroide

Lavorare con i contour plot

Lavorare con lo strumento di interpretazione dei frammenti
Lavorare con i database e i record delle librerie

Aprire i File di Dati

Prerequisito: Il progetto Example deve essere selezionato.

1.

o~ Db

Nella Barra di Navigazione, alla voce Explore, fare doppio clic su Open Data File.
Si aprira la finestra di dialogo Select Sample.

Nell'elenco Data Files, fare doppio clic su Triple Quad.

Selezionare QuanData.wiff.

Nell'elenco Analyte, selezionare il campione AP13-020.

Fare clic su OK.

Saranno mostrati i dati acquisiti dal campione. Se l'acquisizione di dati &€ ancora in
corso, lo spettro di massa, il tracciato DAD/UV e il TIC continueranno ad aggiornarsi
automaticamente.

massa, fare clic col destro sullo spettro di massa e poi fare clic su Show
= Last Scan. Se si vede un segno di spunta a lato di Show Last Scan, lo
spettro si aggiornera in tempo reale.

@ Suggerimento!Per disattivare I'aggiornamento automatico dello spettro di

Navigare tra i Campioni in un File di Dati

Prerequisito: |l progetto Example deve essere selezionato.

La Tabella 6-9 mostra le icone di navigazione usate in questa procedura. Se i campioni sono stati
salvati in file di dati separati, allora aprire ogni file singolarmente.

1.
2.

Nella Barra di Navigazione, alla voce Explore, fare doppio clic su Open Data File.
Nell'elenco Data Files, fare doppio clic su Triple Quad.
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3. Selezionare QuanData.wiff.

Per passare al campione successivo nel file di dati, fare clic sull'icona con la freccia
che punta a destra.

5. Per saltare a un file di dati non in sequenza, fare clic sull'icona con la freccia che
curva a destra.

6. Nella finestra di dialogo Select Sample, nell'elenco Sample, selezionare il
campione.

7. Per passare al campione precedente nel file di dati, fare clic sull'icona con la freccia
che punta a sinistra.

Mostra Condizioni Sperimentali

Le condizioni sperimentali usate per raccogliere i dati sono memorizzate nei file di dati assieme
ai risultati. L'informazione contiene i dettagli del metodo di acquisizione usato: il metodo di
acquisizione MS (ossia il numero di periodi, esperimenti e cicli) che comprende i parametri dello
strumento e il metodo del dispositivo HPLC (velocita di flusso della pompa LC) Inoltre contiene la
risoluzione MS e le tabelle di calibrazione della massa usate per l'acquisizione del campione. La
Tabella 6-1 mostra la funzionalita del software disponibile quando I'utente visualizza le
informazioni sul file.

“wus Nota: Se nello stesso file .wiff sono presenti dati acquisiti da piu di un campione, il
. /A riquadro di informazioni sul file non si aggiornera automaticamente quando l'utente
' scorre attraverso i campioni. Chiudere il riquadro di informazioni sul file e riaprirlo per

vedere i dettagli del campione successivo nel file .wiff.

* Fare clic su Explore > Show > Show File Information.
Si aprira il riquadro File Information sotto il grafico.

Information, fare clic col destro sul riquadro File Information e poi fare clic

< Suggerimento!Per creare un metodo di acquisizione dal riquadro File
/
'~ su Save Acquisition Method.

Tabella 6-1 Riquadro Show File Information: Menu Tasto Destro

Menu Funzione

Copy Copia i dati selezionati.

Paste Incolla i dati.

Select All Seleziona tutti i dati nel riquadro.

Save To File Salva i dati in un file .rtf.

Font Modifica il carattere.

Save Acquisition Method Salva il metodo di acquisizione come file .dam.

Save Acquisition Method to Apre la finestra di dialogo Specify Compound Information.

CompoundDB Selezionare gli ID e i pesi molecolari da salvare nel
database dei composti

Delete Pane Cancella il riquadro.
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Mostra Dati nella Tabella

* Inunfile di dati aperto, fare clic su Explore > Show > Show List Data.
| dati sono mostrati in un riquadro sotto il grafico.

| (509207 50 MCA soans from Sample 1 (EPI 1000 amués, Fill=50ms, @1 unit) of Reserpine.wiff (Tutbo Spray) hax. 3.0e7 cps.
2067 1es.2
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ol B el <o 0229502 | as0z gz 5334.5434 7 A2 e
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miz, amu

+EPI [609.20): 50 MCA scans from Sample 1 [EPI 1000 amu/s, Filll=50ms, @1 unit) of Reserpme.wifl [Turbo Spray)
Data List  Peak List

miz (amu) | Intensity (cps) | Centroid mass (amu) | Peak area (counts) | Charges | Peak start (amu) | Peak end (amu) Wi’
1 161.2000 |1.8333e5 1511271 £.3333e5 1 160 8600 141.3200 0z
2 1521000 |2.5000e5 15211058 1.0167E6 Undefined |151.8600 1525200 0.2
B 153.3600 |1.6667ed 1533484 5.0000e4 Undefined [153.1800 153.4200 0.2
4 1541400 |1.0000e5 154.1400 2.0000e5 1 153.9600 1594.2600 0.1
fa) 1549200 |3.3333e4 154.9200 3.3333e4 Undefined |154.8600 154.9800 01
G 155.2200 |5.0000e4 1552308 1.166Te5 1 154.8600 155.4000 0.6
7 15661800 |1.0000e5 156.1831 3.3333e5 1 155.6400 156.4200 0.2
8 157.0800 |5.0000e4 167 1147 21667e5 1 156 8400 157 4400 01
] 1576800 |3.3333e4 157 6829 3.3333e4 1 157.6200 157.8000 0.2
10 1581000 |2.6667e5 158.1469 9.0000e5 Undefined |157.8000 158.4600 0.1
11 158.5200 |6.6667ed 158,523 6.6667ed Undefined |158.4600 158.7000 0.2
12 1591800 |1.2000e6 1591663 5.7500e6 1 158.8800 159.4800 0.2
13 160.1400  |9.5000e5 1601924 3.9333e6 1 159.9600 160.6200 0.2
14 161.1600 |3.8333e5 161.1998 1.3333e6 1 160.9800 161.4600 01
1‘1 1R7 1800 |4 1RRTRA 1R721718 1477%6R 1 1n|1 a4nn 167 4700 n’1 i

Tabella 6-2 Scheda Spectral Peak List: Menu Tasto Destro

Menu Funzione

Column Options Apre la finestra di dialogo Select Columns for Peak List
Save As Text Salva i dati come file di testo.

Delete Pane Cancella il riquadro.

Tabella 6-3 Scheda Chromatographic Peak List: Menu Tasto Destro

Menu Funzione
Analyst Classic Apre la finestra di dialogo Analyst Classic.
Parameters
IntelliQuan Parameters | Apre la finestra di dialogo Intelliquan.
Save As Text Salva i dati come file di testo.
Delete Pane Cancella il riquadro.
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Show ADC Data

| dati ADC (convertitore analogico-digitale) sono acquisiti da un rivelatore secondario (ad
esempio da un rivelatore UV attraverso una scheda ADC) e sono utili per la comparazione con i
dati dello spettrometro di massa. Per avere a disposizione i dati ADC, acquisire i dati ADC e i dati
dello spettrometro di massa simultaneamente e salvarli nello stesso file.

Prerequisito: Il progetto Example deve essere selezionato.

1.

o w0

6.
7.

Nella Barra di Navigazione, alla voce Explore, fare doppio clic su Open Data File.
Si aprira la finestra di dialogo Select Sample.

Nell'elenco Data Files, fare doppio clic su Devices, poi fare clic su Adc16chan.wiff.
Selezionare un campione nell'elenco Samples.

Fare clic su OK.

Fare clic su Explore > Show > Show ADC Data.

Si aprira la finestra di dialogo Select ADC Channel.

Select ADC Channel [ X| I

IGERGRT S /D Converter - DR OF 2v

Ok Cancel Help

Selezionare un canale nell'elenco Channel.
Fare clic su OK.
| dati ADC si aprono in un nuovo riquadro sotto il riquadro attivo.

Mostrare i Dati Quantitativi di Base

1.

Nella scheda Peak List, fare clic col destro e selezionare Show Peaks in Graph.
| picchi appaiono di due colori.

2. Per modificare le impostazioni dell'algoritmo di rilevamento dei picchi, fare clic col
destro e poi selezionare Analyst Classic Parameters o Intelliquan Parameters,
secondo quale dei due sia attivo.

3. Perrimuovere i picchi colorati, fare clic col destro sulla scheda Peak List e poi
deselezionare Show Peaks in Graph.
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Cromatogrammi

Tabella 6-4 Cromatogrammi

Tipi di cromatogrammi

Funzione

TIC (Total lon Chromatogram -
Cromatogramma Corrente
lonica Totale)

Una visualizzazione cromatografica generata tracciando
l'intensita di tutti gli ioni in una scansione rispetto al tempo o al
numero della scansione.

Quando si apre un file di dati, questo & preimpostato per
essere mostrato in forma di TIC. Se I'esperimento contiene
una sola scansione, & mostrato in forma di spettro. Per
maggiori informazioni sull'uso delle icone disponibili, fare
riferimento alla Tabella 6-8 Opzioni Grafico a pagina87.

Se la casella MCA & spuntata durante I'acquisizione del file di
dati, allora il file di dati si aprira in forma di spettro di massa.
Se la casella MCA non & spuntata, il file di dati si aprira in
forma di TIC.

XIC (Extracted lon
Chromatogram -
Cromatogramma loni Estratti)

Un cromatogramma degli ioni creato prendendo da una serie
di scansioni spettrali di massa i valori di intensita a un valore
unico e distinto di massa o in un range di massa. Indica il
comportamento di una data massa, o di un range di massa, in
funzione del tempo.

BPC (Base Peak
Chromatogram -
Cromatogramma Picco Base)

Un diagramma cromatografico che mostra l'intensita dello ione
piu intenso all'interno di una scansione in funzione del tempo
o del numero della scansione.

TWC (Total Wavelength
Chromatogram -
Cromatogramma Lunghezze
d'Onda Totali)

Una visualizzazione cromatografica creata sommando tutti i
valori di assorbanza nel range delle lunghezze d'onda
acquisite e tracciando i valori rispetto al tempo. Consiste nella
somma delle assorbanze di tutti gli ioni in una scansione,
tracciate rispetto al tempo in un riquadro cromatografico.

XWC (Extracted Wavelength
Chromatogram -
Cromatogramma Lunghezze
d'Onda Estratte)

Un sottogruppo del TWC. Uno XWC mostra I'assorbanza per
una singola lunghezza d'onda o la somma dell'assorbanza per
un range di lunghezze d'onda.

DAD (Diode Array Detector -
Rivelatore a Serie di Diodi)

Un rivelatore UV che controlla lo spettro di assorbimento dei
composti eluenti a una o piu lunghezze d'onda.

Mostrare i TIC da uno Spettro

Prerequisito: Il progetto Example deve essere selezionato.

1. Nella Barra di Navigazione, alla voce Explore, fare doppio clic su Open Data File.

Si aprira la finestra di dialogo Select Sample.

Nell'elenco Data Files, fare doppio clic su LIT, poi fare clic su Reserpine.wiff.

Fare clic su OK.

Fare clic su Explore > Show > Show TIC.

Si aprira il TIC in un nuovo riquadro.
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~ Suggerimento!Fare clic col destro su un riquadro contenente uno spettro,
/ poi fare clic su Show TIC.

&

Mostrare uno Spettro da un TIC

1. Se un riquadro contiene un TIC, selezionare un range.
2. Fare clic su Explore > Show > Show Spectrum.
Si aprira lo spettro in un nuovo riquadro.

~\ Suggerimento!Fare doppio clic sul riquadro TIC in un dato valore di tempo
/ per mostrare lo spettro.

&

Generare gli XIC

L'utente pud generare degli XIC solo dagli spettri o dai cromatogrammi di un singolo periodo e di
un singolo esperimento. Per ottenere uno XIC da dati multi-esperimento o multi-periodo, dividere
i dati in riquadri separati facendo clic sul triangolo posto sotto I'asse X. Per maggiori informazioni
sull'uso delle icone disponibili, fare riferimento alla Tabella 6-8 Opzioni Grafico a pagina87.

Esistono diversi metodi per estrarre gli ioni necessari per generare uno XIC a partire da dati
cromatografici o spettrali. La Tabella 6-5 contiene un riassunto dei metodi che possono essere
usati con i cromatogrammi e gli spettri.

Tabella 6-5 Riepilogo dei Metodi di Generazione degli XIC

Metodo Uso con Uso con Estrazione
cromatogramma | spettro
Selected Range |No Si Il metodo Selected Range estrae gli
ioni da un'area selezionata nello
spettro.
Maximum No Si Il metodo Maximum estrae gli ioni da

un'area selezionata in uno spettro
usando il picco piu intenso nell'area
selezionata. Genera cosi uno XIC
utilizzando la massa maggiore dal
range spettrale selezionato.

Base peak Si No Il metodo Base peak masses pud
masses essere usato solo con i BPC (Base
Peak Chromatogram). L'uso del
comando Use Base Peak Masses per
estrarre gli ioni genera uno XIC con un
tracciato di colore diverso per ogni
massa. Se la selezione include diversi
picchi, lo XIC risultante avra un
numero corrispondente di tracciati
colorati che rappresentano ciascuna
massa.
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Tabella 6-5 Riepilogo dei Metodi di Generazione degli XIC (Continua)

Metodo Uso con Uso con Estrazione
cromatogramma | spettro
Specified masses | Si Si Il metodo Specified masses estrae gli

ioni da qualsiasi tipo di spettro o
cromatogramma. Selezionare fino a
dieci masse di inizio e fine da cui
generare gli XIC.

Generare uno XIC usando un range selezionato

1.

Nella Barra di Navigazione, alla voce Explore, fare doppio clic su Open Data File.
Si aprira la finestra di dialogo Select Sampile.

Nell'elenco Data Files, fare doppio clic su LIT, poi fare clic su Reserpine.wiff.
Fare clic su OK.

Per selezionare un range in un riquadro, fare clic e tenere premuto il pulsante
sinistro del mouse all'inizio del range e trascinare il cursore fino al punto di fine, poi
rilasciare.

La selezione sara evidenziata in blu.
Fare clic su Explore > Extract lons > Use Range.

Uno XIC della selezione specificata si aprira in un riquadro sotto il riquadro dello
spettro. Le informazioni sull'esperimento nell'intestazione del riquadro contengono il
range di massa e l'intensita massima in conteggi al secondo.

Generare uno XIC usando il picco massimo

1.

Nella Barra di Navigazione, alla voce Explore, fare doppio clic su Open Data File.
Si aprira la finestra di dialogo Select Sample.

Nell'elenco Data Files, fare doppio clic su LIT, poi fare clic su Reserpine.wiff.
Fare clic su OK.

Selezionare un range.

La selezione sara evidenziata in blu.

Fare clic su Explore > Extract lons > Use Maximum.

Uno XIC della selezione specificata di picco massimo si aprira in un riquadro sotto il
riquadro dello spettro. Le informazioni sull'esperimento nell'intestazione del riquadro
contengono il range di massa e l'intensita massima in conteggi al secondo.

Generare uno XIC usando le masse dei picchi di base.

1.

Selezionare il picco da cui estrarre gli ioni in un BPC.

La selezione sara evidenziata in blu.

2. Fare clic su Explore > Extract lons > Use Base Peak Masses.
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Uno XIC della selezione specificata si aprira sotto il riquadro dello spettro. Le
informazioni sull'esperimento nell'intestazione del riquadro mostrano il range di
massa e l'intensita massima in conteggi al secondo.

Estrarre gli ioni selezionando le masse
1. Aprire uno spettro o un cromatogramma.

2. Fare clic su Explore > Extract lons > Use Dialog.

Extract lons |

Start Stop

D o

I° I°

I I

I’ I’

o o

I° I°

I I

I’ I’

I° I°

[° [°

,TI Cancel Help

Figura 6-1 Finestra di dialogo Extract lons

3. Immettere i valori in base ai quali sara creato ciascuno XIC. Se non si immette un
valore di fine, il range sara definito dal valore di inizio.

* Nel campo Start, immettere il valore di inizio (valore piu basso) del range di
massa.

* Nel campo Stop, immettere il valore di fine (valore piu alto) del range di
massa.

4. Fare clic su OK.

Uno XIC della selezione si aprira sotto il riquadro del cromatogramma. Le
informazioni sull'esperimento nell'intestazione del riquadro includono le masse e
l'intensita massima in conteggi al secondo.

Generare i BPC

| BPC possono essere generati solo a partire dai dati di un singolo periodo e un singolo
esperimento. Per maggiori informazioni sull'uso delle icone disponibili, fare riferimento alla
Tabella 6-8 Opzioni Grafico a pagina87.
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Selezionare un area all'interno di un TIC.

La selezione sara evidenziata in blu.

Fare clic su Explore > Show > Show Base Peak Chromatogram.
Le selezioni sono mostrate nei campi Start Time e End Time.

Base Peak Chromatogram Options I

Mass Tolerance: |1— amu
Minimum Intensity: Il] cps
Minimum Mass: |1 50 amu
Maximum Mass: I?I]l] amu
v Use Limited Range
Start Time: Il] min
End Time: |1 0o min

oK | Cancel |

Figura 6-2 Finestra di dialogo Base Peak Chromatogram Options

Nel campo Mass Tolerance, immettere il valore per la tolleranza da applicare al
range di massa usato per trovare un picco. Il software trovera il picco usando un
valore pari al doppio del range immesso (z il valore della massa).

Nel campo Minimum Intensity, immettere il valore dell'intensita al di sotto del quale
i picchi saranno ignorati dall'algoritmo.

Nel campo Minimum Mass, immettere la massa che determina l'inizio del range di
scansione.

Nel campo Maximum Mass, immettere la massa che determina la fine del range di
scansione.

Per impostare i tempi di inizio e fine, spuntare la casella Use Limited Range e
immettere quanto segue:

* Nel campo Start Time, immettere il tempo che determina l'inizio
dell'esperimento.

* Nel campo End Time, immettere il tempo che determina la fine
dell'esperimento.

Fare clic su OK.
Il BPC si aprira in un nuovo riquadro.
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Generare gli XWC

L'utente puo estrarre fino a tre range da uno spettro DAD per generare lo XWC. Per maggiori
informazioni sull'uso delle icone disponibili, fare riferimento alla Tabella 6-8 Opzioni Grafico a
pagina87.

1. Aprire un file di dati che contiene uno spettro DAD.
2. Fare clic col destro in una qualsiasi parte del riquadro e poi fare clic su Extract

Wavelengths.
Exoct Wovelonghs |
Start Stop
P g
o o
o g
| oK I Cancel | Help |

Figura 6-3 Finestra di dialogo Extract Wavelengths
3. Immettere i valori di inizio e fine.
4. Fare clic su OK.
Lo XWC si aprira in un riquadro sotto lo spettro DAD.

Mostrare i Dati DAD

L'utente pud visualizzare i dati DAD in forma di cromatogramma o di spettro, allo stesso modo
dei dati dello spettrometro di massa.

1. Aprire un file di dati contenente dati acquisiti con un DAD.
2. I TWC, che & analogo a un TIC, si aprira in un riquadro sotto il TIC.

3. Nel riquadro TWC, fare clic su un punto per selezionare un determinato punto nel
tempo o evidenziare un area dello spettro per selezionare un range di tempo.

4. Fare clic su Explore > Show > Show DAD Spectrum.

Lo spettro DAD si aprira in un riquadro sotto il TWC. L'asse Y mostra l'assorbanza e
I'asse X mostra la lunghezza d'onda.

~ Suggerimento!Se il riquadro con il TWC é chiuso, fare clic su un punto
./ qualunque nel TWC per riaprirlo. Fare clic su Explore > Show > Show
~ DAD TWC.

Generare i TWC

Un TWC mostra I'assorbanza totale (in mAU) sull'asse X, tracciata rispetto al tempo sull'asse X.
Per maggiori informazioni sull'uso delle icone disponibili, fare riferimento alla Tabella 6-8 Opzioni
Grafico a pagina87.

Strumenti AB SCIEX Serie 6500 Guida per I'Utente
84 di 132



Analisi ed Elaborazione dei Dati

1. Aprire un file di dati che contiene uno spettro DAD.
2. Fare clic su Explore > Show > Show DAD TWC.
Il TWC si aprira in un riquadro sotto lo spettro DAD.

~ Suggerimento!Fare clic col destro dentro il riquadro contenente lo spettro
/ DAD e poi fare clic su Show DAD TWC.

=

Regolare la Soglia (Threshold)

La soglia & una linea invisibile tracciata parallelamente all'asse X di un grafico, che imposta un
limite al di sotto del quale il software non includera i picchi in uno spettro. La linea ha un
puntatore, rappresentato da un triangolo blu sulla sinistra dell'asse Y. Fare clic su sul triangolo
blu per mostrare una linea punteggiata che rappresenta la soglia. La soglia pud essere alzata o
abbassata, ma modificare il valore della soglia non comportera modifiche ai dati. Il software non
etichetta alcun picco nella regione che si trova al di sotto della soglia.

1. Aprire un file di dati.
2. Regolare la soglia secondo uno dei seguenti metodi:

» Per alzare la soglia, trascinare il triangolo blu verso I'alto nell'asse Y. Per
abbassare la soglia, trascinare il triangolo blu verso il basso.

* Fare clic su Explore > Set Threshold. Nella finestra di dialogo Threshold
Options che si aprira, immettere il valore della soglia.

* Fare clic su Explore > Set Threshold.

Il grafico sara aggiornato per mostrare la nuova soglia. Saranno aggiornati anche
I'elenco dei picchi e I'etichettatura dei picchi.

~\ Suggerimento!Per visualizzare il valore attuale della soglia, muovere il
/ puntatore del mouse sul puntatore della soglia.

=

Tabella 6-6 Riquadri Cromatogramma : Menu Tasto Destro

Menu Funzione

List Data Elenca i punti dei dati ed integra i cromatogrammi.

Show Spectrum Genera un nuovo riquadro.

Show Contour Plot Mostra un diagramma di un set di dati codificato in base al colore,

dove il colore rappresenta l'intensita dei dati in quel determinato
punto. Sono supportate solo alcune modalita MS.

Extract lons Estrae un determinato ione o un set di ioni da un riquadro selezionato
€ poi genera un nuovo riquadro contenente un cromatogramma per
gli ioni specificati.

Show Base Peak Genera un nuovo riquadro contenente un cromatogramma dei picchi
Chromatogram di base.
Show ADC Data Genera un nuovo riquadro contenente il tracciato dei dati UV, se

sono stati acquisiti.
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Tabella 6-6 Riquadri Cromatogramma (Continua): Menu Tasto Destro

Menu

Funzione

Spectral Arithmetic
Wizard

Apre lo Spectral Arithmetic Wizard.

Save to Text File

Genera un file di testo a partire dal riquadro, che pu0 essere aperto in
Excel o altri programmi.

Save Explore History

Il file Explore History memorizza i cambiamenti ai parametri di
elaborazione, noti anche come Processing Options, quando un file
.wiff & elaborato in modalita Explore. La cronologia dell'elaborazione
€ memorizzata in un file con un estensione .EPH (Explore Processing
History).

Add Caption

Aggiunge una didascalia alla posizione del cursore nel riquadro.

Add User Text

Aggiunge una casella di testo nella posizione del cursore del mouse.

Set Subtract Range

Imposta il range di sottrazione nel riquadro.

Clear Subtract Range

Cancella il range di sottrazione nel riquadro.

Subtract Range Locked

Blocca o sblocca i range di sottrazione. Se i range di sottrazione non
sono bloccati, allora ogni range di sottrazione pud essere mosso in
maniera indipendente. | range di sottrazione sono preimpostati come
bloccati.

Delete Pane

Cancella il riquadro selezionato.

Tabella 6-7 Riquadri Spettro : Menu Tasto Destro

Menu Funzione
List Data Elenca i punti dei dati ed integra i cromatogrammi.
Show TIC Genera un nuovo riquadro contenente il TIC.

Extract lons

Estrae un determinato ione o un set di ioni da un riquadro
selezionato e poi genera un nuovo riquadro contenente un
cromatogramma per gli ioni specificati.

Save to Text File

Genera un file di testo a partire dal riquadro, che pud essere aperto
in Excel o altri programmi.

Save Explore History

Il file Explore History memorizza i cambiamenti ai parametri di
elaborazione, noti anche come Processing Options, quando un file
.wiff & elaborato in modalita Explore. La cronologia dell'elaborazione
€ memorizzata in un file con un estensione .EPH (Explore
Processing History).

Add Caption

Aggiunge una didascalia alla posizione del cursore nel riquadro.

Add User Text

Aggiunge una casella di testo nella posizione del cursore del mouse.

Show Last Scan

Mostra la scansione precedente alla selezione.

Select Peaks For Label

In questa finestra di dialogo si possono selezionare i parametri per
ridurre I'etichettatura dei picchi.

Delete Pane

Cancella il riquadro selezionato.
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Tabella 6-7 Riquadri Spettro (Continua): Menu Tasto Destro

Menu Funzione

Add a Record Aggiunge un record e i dati relativi al composto, inclusi gli spettri,
nella libreria. E necessario uno spettro attivo per eseguire
quest'attivita.

Search Library Lancia una ricerca nella libreria senza restrizioni o con le restrizioni

salvate in precedenza.

Search With Constraints | Lancia una ricerca con restrizioni attraverso la finestra di dialogo
Search Constraints.

Elaborazione dei Dati

| dati grafici possono essere elaborati in molti modi. Questa sezione fornisce informazioni e
procedure per usare alcuni tra gli strumenti adoperati piu frequentemente.

L'utente pud ingrandire una parte di un grafico per visualizzare un determinato picco o un'area a
un maggior livello di dettaglio, sia negli spettri, sia nei cromatogrammi. L'utente puo anche
ingrandire ripetutamente per visualizzare i picchi piu piccoli.

Graphs

Gli stessi dati possono essere esaminati in modi diversi. | dati possono essere mantenuti anche
per essere confrontati tra loro prima di effettuare operazioni di elaborazione, come lo
smussamento o la sottrazione.

Una finestra che contiene uno o piu riquadri € disposta in modo tale che tutti i riquadri sono
pienamente visibili e non sovrapposti.

| riquadri possono essere di dimensione variabile o fissa. | riquadri sono automaticamente
affiancati nella finestra e disposti in formato riga/colonna. Se la dimensione di una finestra viene
modificata, i riquadri all'interno della finestra si ridimensionano per adattarsi alla nuova
dimensione. Una finestra non pu0 essere ridimensionata fino al punto in cui uno dei riquadri
dovesse essere piu piccolo della dimensione minima ammessa.

Due o piu finestre o riquadri contenenti dati simili possono essere collegati. Ad esempio, gl
spettri con range di massa simili. Quando un riquadro o una finestra vengono ingranditi, I'altro
riquadro viene ingrandito contemporaneamente.

Ad esempio, l'utente pud collegare uno XIC al BPC dal quale lo XIC & stato estratto.
L'ingrandimento del BPC ingrandisce lo XIC, in modo tale che entrambi i cromatogrammi
abbiano lo stesso fattore di ingrandimento.

Tabella 6-8 Opzioni Grafico

Per fare questo... usare questa opzione nel menu... ...o fare clic su
quest'icona

Copiare un grafico in |+ Selezionare il grafico da copiare. Fare clic su

una nuova finestra. Explore > Duplicate Data > In New Window. @]
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Tabella 6-8 Opzioni Grafico (Continua)

Per fare questo...

usare questa opzione nel menu...

...0 fare clic su
quest'icona

Riportare il grafico
alle sue dimensioni
originali.

Selezionare il grafico. Fare clic suExplore >
Home Graph.

oy

Spostare un riquadro

Selezionare il grafico. Fare clic su Window >
Move Pane.

» Selezionare il riquadro o la finestra, poi
trascinarli fino alla nuova posizione. Questa
posizione pud essere nella stessa finestra o in
un'altra finestra.

Una freccia a quattro punte viene visualizzata
quando il cursore si trova sul bordo della finestra o
del riquadro attivo.

» Se il riquadro € nella parte superiore o
inferiore del riquadro di destinazione, il
riquadro si sposta al di sopra o al di sotto di
tale riquadro.

» Se il riquadro ¢ alla sinistra o alla destra del
riquadro di destinazione, il riquadro si
sposta alla sinistra o alla destra di tale
riquadro.

» Seilriquadro € in qualsiasi altra posizione, il
riquadro si sposta alla riga di destinazione.
L'ombra del riquadro che compare quando
si sposta il riquadro indica la sua nuova
posizione.

Collegare i riquadri

1. Mentre si hanno due grafici aperti, fare clic su
uno di questi per rendere attivo tale riquadro.

2. Fare clic su Explore > Link e poi fare clic
sull'altro riquadro.

Rimuovere il
collegamento

» Chiudere uno dei riquadri. Fare clic su Explore
> Remove Link

Cancellare un
riqguadro

» Selezionare il grafico. Fare clic su Window >
Delete Pane.

Bloccare un riquadro

» Selezionare il grafico. Fare clic su Window >
Lock Panes.

Nascondere un
riquadro

» Selezionare il grafico. Fare clic su Window >
Hide Pane.

Strumenti AB SCIEX Serie 6500

88 di 132

Guida per I'Utente



Analisi ed Elaborazione dei Dati

Tabella 6-8 Opzioni Grafico (Continua)

Per fare questo... usare questa opzione nel menu... ...o fare clic su
quest'icona
Ingrandire un » Selezionare il grafico. Fare clic su Window >
riguadro a tutto Maximize Pane. D
schermo
Affiancare i riquadri | Selezionare il grafico. Fare clic su Window >
Tile all Panes. E

Ingrandimento sull'asse Y

1. Posizionare il puntatore alla sinistra dell'asse Y e poi trascinarlo verticalmente dal
punto di partenza.

Apparira una casella lungo I'asse Y che rappresenta la nuova scala.

“«s Nota: Fare attenzione quando si ingrandisce la linea di base. Se si
ingrandisce troppo, la casella zoom-in scompare.

2. Rilasciare il bottone del mouse per disegnare il grafico con la nuova scala.

Ingrandimento sull'asse X

1. Posizionare il puntatore sotto I'asse X di uno dei due lati dell'area da espandere e poi
trascinare via dal punto di partenza in direzione orizzontale per espandere I'area
interessata.

2. Rilasciare il bottone del mouse per ridisegnare il grafico con la nuova scala.

Suggerimento!Per riportare il grafico alla dimensione originale, fare
.,/ doppio clic su uno degli assi. Per riportare l'intero grafico alle dimensioni
& originali, fare clic su Explore > Home Graph.

Tabella 6-9 Guida Rapida di Riferimento: Cromatogrammi e Spettro

Icona Nome Funzione
Ij, Open File Apre i file.
- Show Next Sample Passa al campione successivo.
- Show Previous Sample Passa al campione precedente.
pre GoTo Sample Apre la finestra di dialogo Select Sample.
Guida per I'Utente Strumenti AB SCIEX Serie 6500

89 di 132



Analisi ed Elaborazione dei Dati

Tabella 6-9 Guida Rapida di Riferimento: Cromatogrammi e Spettro (Continua)

Icona Nome Funzione
ey List Data Visualizza i dati nelle tabelle.
RE. Show TIC Genera un TIC da uno spettro.
ﬁlﬁ Extract Using Dialog Estrae gli ioni secondo la massa selezionata.
Show Base Peak Genera un BPC.

?‘E Chromatogram

Show Spectrum Genera uno spettro da un TIC.

Al

Copy Graph to new Window | Copia il grafico attivo in una nuova finestra.

el

T Baseline Subtract Apre la finestra di dialogo Baseline Subtract
Threshold Regola la soglia.

pio

= Noise Filter Fare clic per usare la finestra di dialogo Noise Filter

}.-_T.IJ-L Options per definire la larghezza minima di un picco.

| segnali al di sotto di questa larghezza minima
saranno considerati come rumore.

Show ADC Mostra i dati ADC.

-
=]
-

Show File Info Mostra le condizioni dell'esperimento usate per
raccogliere i dati.

s =R

Add arrows Aggiunge le frecce all'asse X del grafico attivo.
o, Remove all arrows Rimuove le frecce dall'asse X del grafico attivo.
++
= Offset Graph Fare clic per compensare le leggere differenze nel
M tempo in cui i dati ADC e i dati dello spettrometro di
massa sono stati registrati. Questo & utile quando si
sovrappongono i grafici per il confronto.
be Force Peak Labels Etichetta tutti i picchi.
n
— Expand Selection By Imposta il fattore di espansione di una porzione di un
w3 grafico per la visualizzazione in dettaglio.
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Tabella 6-9 Guida Rapida di Riferimento: Cromatogrammi e Spettro (Continua)

Icona Nome Funzione
* Clear ranges Riporta la selezione espansa alla vista normale.
—F

Set Selection

Fare clic per immettere i punti di inizio e fine di una
selezione. Offre una selezione piu accurata rispetto
a quella fatta evidenziando la regione con il cursore.

Normalize to Max

Fare clic per normalizzare il grafico in base al valore
massimo, in modo che la sua dimensione sia
stabilita in base a quella del picco piu intenso, che
questo sia visibile 0 meno.

Show History

Mostra un resoconto delle operazioni di elaborazione
dei dati eseguite per un determinato file, come
smussamento, sottrazione, calibrazione e filtraggio
del rumore.

Open Compound Database

Apre il database dei composti.

— Set Threshold Regola la soglia.

+

. Show Contour Plot Mostra i dati selezionati in forma di spettro o di XIC.
i In aggiunta, per i dati acquisiti da un DAD, un

contour plot (diagramma a contorni) pud mostrare i
dati raccolti in forma di spettro DAD o di XWC.

Show DAD TWC

Genera un TWC del DAD.

DAD

Show DAD

Genera un DAD.

A

Extract Wavelength

Estrae fino a tre range di lunghezza d'onda da uno
spettro DAD per generare lo XWC.
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Usare i file di esempio contenuti nella cartella Example per apprendere come selezionare i
campioni per la quantificazione, come selezionare le query preimpostate e creare query per una
determinata tabella, e come analizzare i dati acquisiti. Per ulteriori informazioni su questi
argomenti, fare riferimento alla Guida alle Funzioni Avanzate per I'Utente.

*  Metric Plot
* Disposizione di una Results Table

Analisi Quantitativa

L'analisi quantitativa & usata per determinare la concentrazione di una particolare sostanza in un
campione. Analizzando un campione sconosciuto e confrontandolo con altri campioni contenenti
la stessa sostanza in concentrazioni note (standard), il software pud calcolare la concentrazione
del campione sconosciuto. Il processo comporta la creazione di una curva di calibrazione basata
sugli standard e successivamente il calcolo della concentrazione del campione sconosciuto. Le

concentrazioni calcolate di ciascun campione sono quindi disponibili in una Tabella dei Risultati

denominata Results Table.

Metodi di Quantificazione

Un metodo di quantificazione & un set di parametri usato per generare i picchi in un campione. |l
metodo di quantificazione pud includere parametri utilizzati per individuare e integrare i picchi,
generare le curve degli standard e calcolare le concentrazioni sconosciute. Un metodo di
quantificazione precedentemente salvato pud essere selezionato dal menu Quantitation nel
batch. Per informazioni sulla creazione di un batch, fare riferimento a Creare e Inviare un Batch a
pagina 62.

L'utente pud creare un metodo di quantificazione prima dell'acquisizione dei dati e poi applicare
automaticamente il metodo ai dati quantitativi dopo che il batch & stato completato. In alternativa
un metodo di quantificazione pud essere creato e applicato dopo l'acquisizione.

Possono essere usati tre strumenti per creare un metodo di quantificazione: il Quantitation
Wizard, il Build Quantitation Method, e il Quick Quant.

Build Quantitation Method

Il Build Quantitation Method non genera una Quantitation Results Table, anche se il metodo pud
essere impiegato in seguito nel Quantitation Wizard per creare una Results Table. Il Build
Quantitation Method pud essere impiegato anche per modificare i metodi di quantificazione
esistenti. Questo € il modo piu flessibile per creare un metodo di quantificazione.

Quantitation Wizard

Si pud generare una Results Table nel Quantitation Wizard nello stesso momento in cui si crea
un metodo di quantificazione. In alternativa un metodo di quantificazione esistente pud essere
usato per quantificare differenti set di dati. Questo € il modo pit comune per creare un metodo di
quantificazione.
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Quick Quant

Il Quick Quant fa parte del Batch Editor. Utilizzare il Quick Quant per aggiungere la
concentrazione dei composti prima dell'acquisizione dei dati. Dato che non & stato acquisito
alcun campione, non puod essere selezionato alcun campione rappresentativo, né possono
essere verificati i picchi. Questo processo permette di definire solo i componenti del metodo.

Note sulle Tabelle dei Risultati

Le Results Table riassumono la concentrazione calcolata di un analita in ogni campione
sconosciuto in base alla curva di calibrazione. Le Results Table comprendono anche le curve di
calibrazione e le statistiche relative ai risultati. L'utente pu® personalizzare la Results Table e
visualizzare le varie tabelle dei risultati in una certa disposizione.

| dati di una Results Table possono essere esportati in un file .txt per 'uso in altre applicazioni,
come Microsoft Excel. L'utente pud anche esportare i dati contenuti nell'intera tabella o solo nelle
colonne visibili.

Metodi Quantitativi e Tabelle dei Risultati

Per le procedure descritte di seguito, usare i dati di esempio che sono forniti e installati con il
software. PK Data contiene i batch Mix_Batch1 e Mix_Batch2. Questi batch di esempio sono
usati per dimostrare I'utilita dei metric plot (diagramma delle metriche) per isolare i campioni
problematici. Gli ioni scansionati sono reserpina (609.4/195.0), minoxidil (210.2/164.2),
tolbutamide (271.3/91.1) e rescinnamina (635.4/221.2), che & lo standard interno. |l Batch 1 non
contiene errori in termini di preparazione del campione, mentre il Batch 2 contiene un campione
di QC in cui lo standard interno & stato aggiunto due volte (campione QC2).

Creare un Metodo usando il Quantitation Method Editor

Prerequisiti:
* |l progetto Example deve essere selezionato.
« L'algoritmo Analyst Classic deve essere in uso.

1. Nella Barra di Navigazione, alla voce Quantitate, fare doppio clic su Build
Quantitation Method.

Si aprira la finestra di dialogo Select Sample.
Nell'elenco Data Files, fare doppio clic sulla cartella Triple Quad.
3. Selezionare Mix_Batch_2. wiff.
I campioni del file selezionato appaiono nell'elenco Samples.
Fare clic su OK.
5. Impostare la tabella Internal Standards come di seguito:

i. Nella colonna Name, selezionare rescinnamine.
ii. Nella colonna Q1/Q3, selezionare 635.400/221.185 per ogni standard.

Strumenti AB SCIEX Serie 6500 Guida per I'Utente
94 di 132



Analisi ed Elaborazione dei Dati Quantitativi

standard interni nel metodo di acquisizione, allora il campo Name nella
7 tabella Internal Standards sara compilato automaticamente quando si
sceglie un valore nel campo Q1/Q3.

] Nota: Se il campo Compound ID & stato compilato per i campioni e gli

6. Impostare la tabella Analytes come di seguito:

i. Nella colonna Name, selezionare reserpine.

ii. Nella colonna Internal Standard, selezionare lo standard interno da
associare ad ogni analita.

iii. Nella colonna Q1/Q3, selezionare 609.400/195.039.
iv. Aggiungere uno o pitu composti, se necessario, per un'analisi pit complessa.

““s Nota: Se il campo Compound ID & stato compilato nel metodo di
] acquisizione per i campioni e gli standard interni, allora i campi Name e Q1/

" 4

7 Q3 nella tabella Analytes saranno gia compilati.

7. Fare clic sulla scheda Integration.

8. In generale, i parametri di integrazione preimpostati sono adatti per la maggior parte
dei picchi. Se l'integrazione non & adatta, cambiare I'algoritmo.

9. Fare clic sull'icona Show or Hide Parameters per mostrare gli algoritmi di
integrazione supplementari.

10. Fare clic sulla scheda Calibration. | parametri preimpostati sono adatti per questi
campioni.

11. Salvare il metodo di quantificazione.

Il nuovo metodo pud essere usato quando si crea un batch nel Batch Editor o
quando il Quantitation Wizard & impiegato per generare una Results Table.

“«s Nota: |l metodo di quantificazione pud essere usato solo nel progetto
w/] attivo, a meno che non sia copiato in un altro progetto. Per fare questo, fare

» clic su Tools > Project > Copy Data. Un nuovo progetto dovra essere
creato e selezionato per essere utilizzato.

Creare una Results Table usando il Quantitation Wizard

Prerequisiti
* |l progetto Example deve essere selezionato.
» L'algoritmo Analyst Classic deve essere in uso.

1. Nella Barra di Navigazione, alla voce Quantitate, fare doppio clic su Quantitation
Wizard.

Si aprira la pagina Create Quantitation Set - Select Samples.

Nell'elenco Available Data Files, fare doppio clic sulla cartella Triple Quad.
3. Selezionare Mix_Batch_2.wiff.

Fare clic su Add All Files.
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5. Fare clic su Next.
Si aprira la pagina Create Quantitation Set - Select Settings & Query.
Nella sezione Default Query, fare clic su Select Existing: Query.
Nell'elenco Query, selezionare Accuracy 15%.
Fare clic su Next.

““q Nota: Per creare una query nello stesso momento, fare riferimento a
g /] Creare una Standard Query a pagina 96.

4

Si aprira la pagina Create Quantitation Set - Select Method.
9. Fare clic su Choose Existing Method.
10. Nell'elenco Method, selezionare PK Data_Mix.gmf.
11. Fare clic su Finish.

Si aprira la tabella Results Table.

Suggerimento!Per aggiungere o rimuovere campioni nella Results Table,
/ fare clic su Tools > Results Table > Add/Remove Samples.

&

12. Salvare la Results Table.

Creare una Standard Query

Una query e una standard query possono essere create in diversi modi. Di seguito un esempio.
Per maggiori informazioni sulla creazione delle query, fare riferimento al menu Help del software.

1. Nella Barra di Navigazione, alla voce Quantitate, fare doppio clic su Quantitation
Wizard.

Nella pagina Create Quantitation Set - Select Samples, selezionare i campioni.
3. Fare clic su Next.

Nella pagina Select Settings & Query, alla sezione Default Query, selezionare
Create New Standard Query.

5. Immettere un nome per la query.
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Create Quantitation Sel - Select Settings & Query @
Please sebact the setings for the rev resuls bable and the delall quedy [if ang) Integration Algoithen: Anakest Classic
Settngs to Use v
Diafault Query
(%) Mo
() Select Existing
Query: | Accuacy 155 » [ Execube Query as Standad Quesy
() Create Mew Standard Query
Mame:
[ <Back [ MNea> [ Comel | [ Heo |

Figura 7-1 Pagina Create Quantitation Set - Select Settings & Query

6. Fare clic su Next.

Create Quantitation Set - Create Default Query B I

Please specify the concentrations/sample names and the coresponding allowed accuracy
variations [in percent). You can leave any of the "variation” fields empty as desired.

Maximum Allowed Accuracy Variation for OCs (%) M aximum Allowed Accuracy Variation for Standards (%)
Concentration Max. Yariation |~ | Concentration Max. Yariation |~ |
- -

[T Query By Name

< Back || MHest > I Einish | Cancel I Help

Figura7-2 Pagina Create Default Query

7. Nella tabella Maximum Allowed Accuracy Variation for QCs (%) , alla colonna
Max. Variation immettere la percentuale di variazione massima permessa per ogni
QC (ad esempio, 5 & £5%) nella stessa riga della concentrazione corrispondente. Se
le concentrazioni non sono state specificate durante I'acquisizione, non appariranno
in questa pagina. In questo caso scriverle nella colonna Concentration.

8. Nella tabella Maximum Allowed Accuracy Variation for Standards (%) , alla
colonna Max. Variation immettere la percentuale di variazione massima permessa
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per ogni standard (ad esempio, 10 & £10%) nella stessa riga della concentrazione
corrispondente. Se le concentrazioni non sono state specificate durante
I'acquisizione, non appariranno in questa pagina. In questo caso scriverle nella
colonna Concentration.

9. Fare clic su Next.

Create Quantitation Set - Select Method E |

Specify whach method will be used for this quantitation set, of create Integration Algorthm: Analpst Classic
& rew miethod row.

% Choose Exsting Method
Method: |New Method 2 qmi =

" Creste New Method
Methad Mame: ||

" Create "Sutomatic’ Method [to tabulate area for each avalable ion)
[ <ok ] e | Erish | camcel | Hep |

Figura 7-3 Pagina Create Quantitation Set - Select Method

10. Selezionare o creare un metodo.
11. Fare clic su Finish.

La query é applicata come una standard query. | risultati della query sono mostrati
come una voce Pass (Riuscito) o Fail (Non riuscito) nella colonna Standard Query
Status nella Results Table.

~ Suggerimento! Per ritornare alla visuale completa, fare clic col destro e
/ poi fare clic su Full.

&

Results Table: Menu Tasto Destro

Fare clic col destro nella tabella Results Table per accedere alle seguenti opzioni.
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Sample Name Sample ID | Sample Typal"
1 |sTD1 Standard ;
2 STD 1 Ful Standard Y
3 STD 1 Summary 5 Standard )
4 STD1 analyte » Standard
5 STD 2 Analyte Group 3 Standard '
6 STD 2 Sample Type r Standard L
7 STD 2 Add Formula Column Standard ,
8 STD 2 Standard
g |sTD3  Table Settings C Standard i
10 |sTD3 g;‘i”‘ . Standard i
11 [STD3 e piot , Standard ?
12 STD 3 Standard
13 STD 4  Delete Pane Standard IR
14 |sTD 4|  FillDown Standard }'
15 STD 4 aAdd Custom Column Standard
16 STD 4 Delete Custom Column Standard 3
EEA X — N,..ﬁ_,-&-" \..ﬁb"‘ﬂ_dy‘“f

Figura 7-4 Results Table:

Menu Tasto Destro

Menu Funzione

Full Mostra tutte le colonne.
Summary Mostra determinate colonne.
Analyte Mostra un determinato analita.

Analyte Group

Crea un gruppo di analiti.

Sample Type

Mostra i campioni di un determinato tipo o tutti i campioni.

Add Formula Column

Aggiunge una colonna Formula.

Table Settings

Modifica o seleziona un'impostazione della tabella.

Query Crea o seleziona una query.

Sort Fare clic per ordinare o indicizzare.

Metric Plot Crea un diagramma delle metriche.

Delete Pane Cancella il riquadro attivo.

Fill Down Inserisce gli stessi dati nelle celle selezionate.

Add Custom Column

Aggiunge una colonna personalizzata.

Delete Custom Column

Cancella la colonna personalizzata selezionata.

Verifica e Integrazione Manuale dei Picchi

Utilizzare la verifica dei picchi (peak review) per passare in rassegna i picchi identificati dal
software, per poi ridefinire i picchi o i punti di inizio e fine ove richiesto.

Dopo aver identificato gli analiti e gli standard interni che il software dovra trovare, il software
localizzera i picchi nel campione. Quando il software identifica un picco, mostra i cromatogrammi
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per ogni analita e gli standard interni alla pagina Create Quantitation Method: Define Integration
dello Standard Wizard o nella scheda Integration del Full Method Editor. L'utente pud verificare i
picchi localizzati o cambiare il metodo di quantificazione per definire i picchi con piu precisione.

Verifica dei Picchi

Durante la verifica dei picchi, l'utente potrebbe voler vedere un picco nella sua interezza, o
potrebbe voler esaminare i valori della linea di base per determinare se il software ha definito con
precisione i punti di inizio e fine del picco. Utilizzare la caratteristica zoom automatico per fare
ambedue le cose.

Per aiutare il software a localizzare un picco, definire i punti di inizio e fine del picco e dello
sfondo manualmente. Questi cambiamenti saranno applicati solo a quel determinato picco, a
meno che non sia aggiornato il metodo generale.

~ Suggerimento!Per verificare un singolo picco, fare clic su un punto della curva e poi
/  fare clic su Show Peak. Il software mostra la finestra Peak Review con il picco
& selezionato.

Fare clic col destro nella Results Table, poi fare clic su Analyte.
Selezionare un campione.

3. Fare clic su Tools > Peak Review > Pane.
| picchi elencati nella Results Table appaiono sotto la tabella.
Fare clic col destro nel riquadro e poi fare clic su Options.

5. Nella finestra Peak Review Options, nella sezione Appearance, impostare Num.
rows a 1 e Num. columns a 2.

6. Nella sezione Automatic Zooming, fare clic su Zoom Y axis to: 100% of largest
peak per mostrare l'intero picco.
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Peak Review Options
Appearance Butomatic Zooming
Hum. mws. |1 "I Zoom ' =iz bo
- fe |100.00 %
Mum. columnz: - I % of laiges! peak

£~ I'I 0000 o laigest peak for al s2mples

£ Iﬁ-':'] limes the bazsline beigt

[ Sk zample ype in e

—Irkemnal Skandand A e ——————— £~ |1-|:|:|'=5 Ak Wity
1~ Don't iaview inteimal slandards e I1.IIIaE i aes unils o laiges! peak
Bewev before al anakies
(Summaty Layaut orily) [~ Zoom lira 2 bo view pack
1# Aeviow wilh aach anzlyte Zaom wirdow Izm i

Marual Inbzgrabon [Fercent Huk)
Refect mansl integation §difersmee in new ares e less ther, [0 'I = af ciighal area

o | Cancs | Help |

Figura7-5 Finestra di dialogo Peak Review Options

Elemento | Definizione
1 Num. rows
2 Num. columns
3 Zoom Y axis to 100% of largest peak

Fare clic su OK.

Per spostarsi tra i picchi, fare clic sulla freccia rivolta a destra. Fare riferimento alla
Figura 7-6 Riquadro Peak Review a pagina 102.S

9. Andare alla seconda iniezione dello standard 3.

In questo esempio il picco pud essere integrato piu vicino alla linea di base
selezionando l'opzione Specify Parameters.

~ Suggerimento!Per spostarsi su un determinato picco nel riquadro Peak
/ Review, selezionare la riga corrispondente nella Results Table.

=
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Figura 7-6 Riquadro Peak Review
Elemento | Descrizione
1 Frecce: fare clic per muoversi tra i picchi.
2 Show or Hide Parameters: fare clic per mostrare i parametri di
integrazione.
3 Integration parameters: fare clic per modificare i parametri.

10. Fare clic due volte su Show or Hide Parameters.
11. Fare clic su Specify Parameters -MQ lIl.
12. Modificare il valore Noise Percent.
13. Fare clic su Apply.
Il picco € integrato piu vicino alla linea di base.

14. Se questa modifica non migliora l'integrazione dei picchi, allora regolare il parametro
Noise Percent fino a trovare il valore ottimale.

15. Per aggiornare gli algoritmi per tutti i picchi, fare clic col destro sul riquadro e poi fare
clic su Update Method.

quel determinato analita (o standard interno) e non per tutti gli analiti.

‘@WJ Nota: La funzione Update Method aggiorna solo i valori dell'algoritmo per
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Figura 7-7 Update Method

Integrazione Manuale dei Picchi

L'integrazione manuale dei picchi dovrebbe essere svolta per ultima. Integrare i picchi
manualmente solo se non sono stati trovati tutti i picchi dopo la regolazione e I'aggiornamento
dei parametri dell'algoritmo. Questo & fatto per limitare la variabilita da persona a persona.

g

Nota: | picchi che sono stati integrati manualmente, o dove I'algoritmo & stato
modificato solo per quel determinato picco, sono identificati come tali nella colonna
Record Modified della Results Table, dato che le modifiche nei parametri dell'algoritmo
sono state fatte per un determinato campione, ma non sono state applicate all'intero
gruppo degli analiti.

Nel riqguadro Peak Review, fare clic su Manual Integration Mode.

1 | » | Jx| _AI_.&.I OI LA.ILL[Ll ‘E}| Aoy | | Accem | Earma=l st e i
Beg. Start: '. l Bkg. End: I 5
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 Soeciy Parameters - MQll Pach Spltting Factor. |2 v ™ Repont Larest Pask
ST 3« rogerping (Standard) 609.4/195.0 Da - sample € of 49 from Mix_bateh_2.wifi BTO 3 - minos
Area: 6.69e+002 counts Heigirt: 9.26e+002 cps AT 207 min Aren: T4Be+00
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E00
a = 200000
- | =
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- = 200000
] 000
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Figura 7-8 Riquadro Peak Review: Manual integration

Elemento | Descrizione

1 Manual Integration Mode

2. Ingrandisce sull'area piu bassa (10%) del picco.

200 4

500 4

700

=00

......

{10 -|
i :i Lt e . R . sy iy g s 4 - n'n-"'.-l..., W
nr i i 20 o]

Figura 7-9 Riquadro Peak Review: Ingrandire su un picco

Elemento | Descrizione

1 10% piu basso del picco

3. Posizionare il mirino nel punto di inizio del picco e poi trascinare il mirino fino alla fine
del picco da definire.

Il software oscura I'area delimitata dalla base e dai lati del picco. | parametri del
picco sono di colore grigio, dato che non sono piu applicabili in quanto il picco € stato
tracciato a mano.

4. Compiere una delle seguenti operazioni:
» Per rendere questa modifica permanente, fare clic su Accept.

* Per abbandonare le modifiche, togliere la spunta alla casella Manual
Integration.

~ Suggerimento!Se un picco era corretto nella sua forma originale, fare clic
/ col destro sul picco e poi fare clic su Revert to Method.

&

Peak Review: Menu Tasto Destro

Fare clic col destro nella finestra o nel riquadro Peak Review per accedere alle seguenti opzioni.

Strumenti AB SCIEX Serie 6500 Guida per I'Utente
104 di 132



Analisi ed Elaborazione dei Dati Quantitativi

JRN 0 TS e [ N 1) Y

Blg. Star: I A Blcg. End: I A
I 5 195.0 Da - sample T of 49 from

+  Sample Annotation... Esoewoz cps RT: 2.08 min
Save Active to Text File...

" Show First Page

Show Last Page
U Slide Show Peak Review

oy
S g Update Method
= Rewvert o Method
Z
a2 0. Delete Pane
=

0.20 1

0.00

1
o

0.5 1.0 1.5 20

Figura 7-10 Peak Review: Menu Tasto Destro

Menu Funzione
Options Apre la finestra di dialogo Peak Review Options.
Sample Annotation Apre la finestra di dialogo Sample Annotation.

Save Active to Text File Salva il picco selezionato come file di testo.

Show First Page Passa al primo campione.

Show Last Page Passa all'ultimo campione.

Slide Show Peak Review | Apre una galleria di immagini sequenziali.

Update Method Aggiorna l'algoritmo per tutti i picchi.

Revert to Method Fare clic per riselezionare un picco ridefinito in base al metodo di
quantificazione corrente.

Delete Pane Cancella il riquadro attivo.

Curve di Calibrazione

Usare le curve di calibrazione per trovare la concentrazione calcolata dei campioni, inclusi i
campioni QC (controllo qualita). | campioni QC o Controllo Qualita sono aggiunti a un batch per
valutare la qualita dei dati e la precisione degli standard nel batch. | campioni QC hanno
concentrazioni di analita note, ma sono elaborati come sconosciuti, in modo tale che le
concentrazioni misurate possano essere comparate con il valore reale.

La curva di calibrazione & generata tracciando la concentrazione dello standard rispetto alla sua
area o la sua altezza. Se si usa uno standard interno, sara tracciato il rapporto tra la
concentrazione di uno standard e quella di uno standard interno rispetto al rapporto tra l'altezza o
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I'area del picco dello standard rispetto all'altezza o I'area del picco dello standard interno. I
rapporto dell'area o dell'altezza di un campione € successivamente applicato a questa curva per
determinare la concentrazione del campione, come mostrato nella Results Table. Sara generata
un'equazione di regressione per questa curva di calibrazione, secondo la regressione
specificata. L'equazione di regressione € usata per calcolare la concentrazione dei campioni
sconosciuti.

Visualizzare le Curve di Calibrazione

L'utente puo visualizzare la curva di calibrazione e modificare le opzioni di regressione in una
Results Table aperta. Se ci sono due o piu Results Table aperte, le curve di calibrazione possono
essere sovrapposte. Per sovrapporre le curve, il metodo usato per creare le varie tabelle deve
essere identico.

Tracciare una curva di calibrazione per vedere la curva usata per la regressione. |l campo
Calibrated Concentration nella Results Table riflette tutti i cambiamenti conseguenti
all'adattamento della curva ai punti dello standard.

} Nota: Quest'opzione € disponibile solo quando una Results Table & aperta nell'area di
lavoro.

1. Nella tabella Results Table attiva, fare clic su Tools > Calibration > Pane.
Si aprira il riquadro Calibration Curve che contiene la curva di calibrazione.

2. Sesiéin presenza di piu di un analita, allora effettuare i seguenti passi per
visualizzare la curva di calibrazione per un altro analita:

i. Nell'elenco Analyte, selezionare un analita.
ii. Se richiesto, nell'elenco successivo, selezionare Area o Height (Altezza).

3. Per modificare le opzioni di regressione per la curva di calibrazione, fare quanto
segue:

i. Fare clic su Regression.

Regression Options E3
£ TR

Weighting: I MNone j r

oK Cancel | Help

Figura 7-11 Finestra di dialogo Regression Options

ii. Selezionare Linear nell'elenco Fit.
iii. Selezionare 1/ x nell'elenco Weight.
iv. Fare clic su OK.
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Si aprira la curva di calibrazione. L'utente puo verificare i singoli picchi della curva o
escludere punti dalla curva per produrre una curva migliore.

4. Se necessario, ripetere questi passi per creare una curva piu appropriata.
Per salvare le modifiche fare clic su Accept.

Sovrapporre le Calibration Curves

“«ws Nota: Per portare in primo piano la curva di una tabella, fare clic sulla curva e poi fare
clic su Active Plot. Selezionare la curva da tracciare in primo piano.

1. Con due o piu Results Table aperte, visualizzare una curva di calibrazione per una
delle tabelle.

2. Fare clic col destro sulla curva di calibrazione e poi fare clic su Overlay.

vINew results tabledb
MNew results table2. rdb

1] 4 Cancel Help

Figura 7-12 Finestra di dialogo Overlay
3. Selezionare le tabelle da sovrapporre alla curva corrente.
4. Fare clic su OK.
Il software traccia le curve per ogni tabella selezionata nello stesso grafico.

Curva di Calibrazione: Menu Tasto Destro

Fare clic col destro nella finestra o nel riquadro della tabella Calibration per accedere alle
seguenti opzioni.
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Figura 7-13 Curva di Calibrazione: Menu Tasto Destro

Menu Funzione

Exclude (Include) Fare clic col destro sul punto e poi fare clic su Exclude per
escludere il punto dalla curva. Fare clic col destro sul punto e poi
fare clic su Include per includere il punto scartato.

Exclude All Analytes Fare clic col destro su un punto e poi fare clic su Exclude All
(Include All Analytes) Analytes per escludere tutti gli analiti dalla curva. Fare clic col
destro su un punto e poi fare clic su Include All Analytes per
includere i punti.

Show Peak Fare clic per verificare un determinato picco.

Overlay Sovrappone due grafici.

Active Plot Determina quale diagramma ¢ attivo.

Legend Mostra la legenda del grafico.

Log Scale X Axis* Fare clic per usare una scala logaritmica per l'asse X.
Log Scale Y Axis* Fare clic per usare una scala logaritmica per l'asse Y.
Delete Pane Cancella il riquadro attivo.

Home Graph Riporta il grafico alle sue dimensioni originali

* Una scala logaritmica dispone i punti dei dati in un modo piu gestibile, in modo tale
che I'effetto di tutti i punti puo essere controllato contemporaneamente. Per avere
questa visuale, selezionare Log Scale Y Axis versus Log Scale X, e non la scala
logaritmica su un solo asse.

Statistiche del Campione

Usare la finestra Statistics per visualizzare le statistiche sui campioni, generalmente per gl
standard e i QC (controlli qualita). | dati per ogni batch disponibile nella Results Table si aprono in
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forma tabulare nella griglia e viene mostrata una riga di dati per la concentrazione di ciascuno
standard o QC.

Visualizzare le Statistiche per Standard e QC

Quando si visualizza piu di una Results Table, le informazioni statistiche sugli standard e i QC
per i batch aggiuntivi possono essere ottenuti nella finestra Statistics. Questo permette all'utente
di confrontare i risultati tra i batch e verificare gli andamenti e le tendenze negli standard o nei

QC.

LN~

Nella tabella Results Table attiva, fare clic su Tools > Statistics.
Nell'elenco Statistics Metric, selezionare Concentration.

Nel campo Analyte Name, selezionare un analita.

Nel campo Sample Type, selezionare Standard.

Appariranno i risultati.

Osservare le colonne %CV e Accuracy.

La colonna %CV mostra il coefficiente di varianza tra le misurazioni di ogni singolo
parametro, ad esempio l'area. La colonna Accuracy mostra la vicinanza del punto
tracciato rispetto al valore interpolato.

Se necessario spuntare la casella Display Low/High values ed esaminare i valori
Low, High, e Mean (Basso, Alto e Medio, rispettivamente) per ogni riga della griglia.
Ogni riga rappresenta gli standard che hanno gli stessi livelli di concentrazione.

Selezionare un altro analita.
| risultati sono mostrati divisi per analita.

Per verificare le variazioni dei QC agli stessi livelli di concentrazione, selezionare QC
nel campo Sample Type.

Confrontare i Risultati tra i Batch

Il numero e i nomi degli analiti devono essere identici per i dati da combinare nel riquadro

Statistics.

1.
2.
3.

Aprire le Results Table
Fare clic su Tools > Statistics.
Compiere una delle seguenti operazioni:

e Perriordinare i risultati nella Results Table, nell'elenco Conc. as Rows,
selezionare Group By Batch.

« Per ordinare i risultati in base alla concentrazione, nell'elenco Conc. as
Rows, selezionare Group By Concentration.

+ Perordinare i risultati in base alla concentrazione, ma senza una riga che
mostri le statistiche per ogni gruppo o batch, nell'elenco Conc. as Rows,
selezionare Group By Concentration (no All).

Il software ordinera i risultati. Una o due righe aggiuntive appariranno alla fine di ogni
batch o gruppo: All (statistiche per tutte le Results Table in quel gruppo) e Average
(statistiche sulle statistiche di quel batch o gruppo).
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Tabella 7-1 Scheda Integration e Icone Quantitation Wizard

Icona Nome Funzione
Set parameters from Utilizza il picco selezionato.
_A Background Region
Select Peak Utilizza lo sfondo selezionato.
_M
I Manual Integration Mode Fare clic per integrare manualmente i picchi.

Show or Hide Parameters Fare clic per rendere visibili o invisibili i parametri di
rilevamento dei picchi.

)

Show Active Graph Mostra solo il cromatogramma dell'analita.

=

Show Both Analyte and IS | Mostra I'analita e cromatogramma ad esso
|ﬂ.|.|1 associato (disponibile solo quando esiste uno
standard interno associato)

Use Default View for Graph |Ritorna alla vista preimpostata (tutti i dati visibili, ad
E:F esempio, se l'utente ha usato lo zoom su un
cromatogramma).

Tabella 7-2 Icone della Results Table

Icona Nome Funzione

Sort Ascending by Selection |Fare clic per ordinare la colonna selezionata per
valori ascendenti.

il

— Sort Descending by Ordinare la colonna selezionata per valori

Bl Selection discendenti.

— Lock or Unlock Column Blocca o sblocca la colonna selezionata. Una

colonna bloccata non puo essere spostata.
Metric Plot by Selection Crea un diagramma delle metriche dalla colonna

@ selezionata.

= a Show all Samples Mostra tutti i campioni nella Results Table.

-,

ﬂ Delete Formula Column Cancella le colonne Formula.

Tabella 7-3 Riferimento Rapido Icone: Modalita Quantitate

Icona Nome Funzione
Add/Remove Samples Aggiunge o rimuove campioni nella Results Table.
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Tabella 7-3 Riferimento Rapido Icone: Modalita Quantitate (Continua)

Icona Nome

Funzione

Export as Text

Salva la Results Table come file di testo.

Modify Method

Fare clic per aprire un file .wiff.

Peak Review - Pane

Apre i picchi in un riquadro.

Apre i picchi in una finestra.

Calibration - Pane

&
m Peak Review - Window
¥

Apre la curva di calibrazione in un riquadro.

Calibration - Window
[

Apre la curva di calibrazione in una finestra.

Show First Peak

Mostra il primo picco nel riquadro o nella finestra.

Show Last Peak

Mostra l'ultimo picco nel riquadro o nella finestra.

Show Audit Trail Mostra il tracciato di controllo per la Results Table.
Clear Audit Trail Cancella il tracciato di controllo per la Results Table.
Statistics Apre la finestra Statistiche.

. Report Generator

Apre il software Reporter.
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Requisiti e Parametri per gli Strumenti Serie A

6500

Questa appendice contiene i requisiti per I'elettricita e il gas e i parametri per gli strumenti degli
strumenti della serie 6500.

Requisiti di Elettricita e Gas

La tabella seguente contiene i valori di tensione in ingresso nominale, fluttuazione della tensione
in ingresso, frequenza, potenza massima in ingresso e corrente massima in ingresso, ove
opportuno.

Tabella A-1 Requisiti Elettrici

Componente Valori

Strumento da 200 a 240 V, +10% della tensione nominale, 50/60 Hz, 10 A,
1000 VA

Pompa per vuoto primaria da 200 a 240 V, £10% della tensione nominale, 50/60 Hz, 4,2 A

(Leybold) (50 Hz), 4,7 A (60 Hz), 2420 VA (50 Hz), 2250 (60 Hz)

Pompa per vuoto primaria da 200 a 240 V, £10% della tensione nominale, 50/60 Hz, 1,76

(Varian) A, 1200 VA

Banco strumenti da 100 a 240 V, +10% della tensione nominale, 50/60 Hz, 1 A,
240 VA

Computer da 115 a 230V, +10% della tensione nominale, 50/60 Hz, 6/3 A,
690 VA

Monitor da 100 a 240 V, +6/-10% della tensione nominale, 50/60 Hz, 1,5
A, 360 VA

La seguente tabella contiene i requisiti del gas per gli strumenti della serie 6500.
Tabella A-2 Requisiti del Gas

Gas Descrizione Requisiti

Gas 1/Gas 2 Aria di zero Aria di zero a 100 psi (max.); portata
di 22 L/min.

Erogazione Curtain Azoto ultra puro UHP (N2) N2 UHP a 60 psi (max.); portata di

Gas™ ; gas CAD 10 L/min.

Scarico della sorgente | Aria ambiente, aria di zero o | Aria ambiente, aria di zero o N2 UHP

N2 UHP a

55 psi; portata di 8 L/min. Non far
funzionare sotto i 55 psi.
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Parametri degli Strumenti

La seguente tabella contiene parametri generici per gli strumenti della serie 6500. Il primo
numero sotto ogni tipo di scansione ¢ il valore predefinito; l'intervallo di numeri € la gamma

accessibile per ogni parametro.

Tabella A-3 Parametri per gli Strumenti Serie 6500

(1)Sorgente ionica lonSpray™ (2)Sorgente ionica TurbolonSpray
Riscaldato (4)Sorgente ionica DuoSpray™ , 1=TIS, e 2=HN (5)Sorgente ionica
PhotoSpray® (6)Sorgente ionica NanoSpray® (7)Sorgente ionica lonDrive™ Turbo V
(8)Sorgente lonDrive Turbo V a Nebulizzatore Riscaldato (a) Sistema AB SCIEX QTRAP®
6500 LM (Low Mass) (b) Sistema AB SCIEX QTRAP 6500 HM (High Mass) (c) Sistema AB
SCIEX Triple Quad™ 6500 LM (d) Sistema AB SCIEX Triple Quad 6500 HM

ID Accesso |Modalita ioni positivi Modalita ioni negativi

Q1 Q3 MS/MS Q1 Q3 MS/MS
CUR'™ 20 20 20 20 20 20

da10a55 |da10ab5 |da10ab55 |da10a55 |da10ab5|da10a 55
%{7%1))(2)(5)(4) 20 20 20 20 20 20

da10ab55 |da10ab5 |da10ab55 |da10ab55 |da10ab55 da10ab55
CAD@®) 0 6 Medio 0 6 Medio

Fisso Fisso Basso, Fisso Fisso Basso,

Medio, Alto Medio, Alto

CAD®N9) 0 6 6 0 6 6

Fisso Fisso dal0a12 Fisso Fisso dal0a12
1SN 5500 5500 5500 -4500 -4500 -4500

da 0a 5500 [da0ab5500 da0ab5500 ga -4500 a ga -4500a |[da-4500a0
IS®) 1500 1500 1500 -1500 -1500 -1500
lon Transfer |da 0a 2500 |da0a2500 da0a?2500 |da-2500a |da-2500a |da-2500a0
Voltage 0 0
1S(®) 1000 1000 1000 -1000 -1000 -1000

da 0 a4000 |da0a4000 da0a4000 ga -4000 a ga -4000a |[da-4000a0
NCENA)E) 3 3 3 -3 -3 -3

daOab da0ab daOab da-5a0 |(da-5a0 |da-5a0
TEM@EIHE) [o 0 0 0 0 0
e da0a750 |da0a750 |da0a750 |daOa750 daOa750 da0a750
DP 100 100 100 -100 -100 -100

da0a300 |da0a300 |da0a300 |da-300a0 ga -300a |da-300a0
EP 10 10 10 -10 -10 -10

da2a15 da2a15 da2a15 da-15a-2 |da-15a-2|da-15a-2

® (3)Nebulizzatore
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Tabella A-3 Parametri per gli Strumenti Serie 6500 (Continua)

ID Accesso |Modalita ioni positivi Modalita ioni negativi
Q1 Q3 MS/MS Q1 Q3 MS/MS
CEM 1150 1150 1150 1150 1150 1150
da0a3300 [da0a3300|da0a3300 [dala daOa da 0 a 3300
3300 3300
GSH1 20 20 20 20 20 20
da0a90 da0a9 |da0a90 da0a90 [(da0a90 |da0a90
GS2 0 0 0 0 0 0
da0a90 da0a9 |da0a90 da0a90 |(da0a90 |da0a90
IHT®) 150 150 150 150 150 150
da0a250 |da0a250 |da0a250 |da0a250 |da0a250 |da0a250
sdp™® 1 1 1 1 1 1
102 102 102 102 102 102
EX2 0 0 0 0 0 0
Fisso Fisso Fisso Fisso Fisso Fisso
Q1 Qo0 + (-0,5) |QO0+(-0,5) |QO0+(-0,5) |QO+(0,5) [QO + (0,5) |QO + (0,5)
(IQ1=Q0 +
offset)
ST1 Q0+ (-10) |QO+(-10) |QO0+(-10) |QO+(10) |[QO+ (10) |QO + (10)
(ST1=Q0 +
offset)
IE1 1,0 n/a 1 -1 n/a -1
(IE1=Q0 - da0a3 da0a3 da-3a0 da-5a0
RO1)
1Q2 Q0+ (-10) |QO+(-10) |QO+(-10) |QO+(10) [QO+(10) |QO+ (10)
(1Q2 =Q0 +
offset)
RO1 n/a QO + (-1) n/a n/a Q0+ (1) |n/a
RO2 -20 -20 n/a 20 20 n/a
Fisso Fisso Fisso Fisso
CE n/a n/a 30 n/a n/a -30
(CE=QO0 - da5a180 da-180a-5
RO2)

(1)Sorgente ionica lonSpray™ (2)Sorgente ionica TurbolonSpray® (3)Nebulizzatore
Riscaldato (4)Sorgente ionica DuoSpray™ , 1=TIS, e 2=HN (5)Sorgente ionica
PhotoSpray® (6)Sorgente ionica NanoSpray® (7)Sorgente ionica lonDrive™ Turbo V
(8)Sorgente lonDrive Turbo V a Nebulizzatore Riscaldato (a) Sistema AB SCIEX QTRAP®
6500 LM (Low Mass) (b) Sistema AB SCIEX QTRAP 6500 HM (High Mass) (c) Sistema AB
SCIEX Triple Quad™ 6500 LM (d) Sistema AB SCIEX Triple Quad 6500 HM
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Tabella A-3 Parametri per gli Strumenti Serie 6500 (Continua)

ID Accesso |Modalita ioni positivi Modalita ioni negativi
Q1 Q3 MS/MS Q1 Q3 MS/MS
ST3 RO2 + (-10) |n/a n/a RO2 +10 |n/a n/a
(ST3=RO2 +
offset)
CXP n/a 15 15 n/a -15 -15
(CXP =RO2 - da0ab5 |da0Oab5 da-55a0 |da-55a0
ST3)
RO3 -50 n/a n/a 50 n/a n/a
Fisso Fisso
IE3 n/a 2 2 n/a -2 -2
dalOab daOab da-5a0 |da-5a0

(1)Sorgente ionica lonSpray™ (2)Sorgente ionica TurbolonSpray® (3)Nebulizzatore
Riscaldato (4)Sorgente ionica DuoSpray™ , 1=TIS, e 2=HN (5)Sorgente ionica
PhotoSpray® (6)Sorgente ionica NanoSpray® (7)Sorgente ionica lonDrive™ Turbo V
(8)Sorgente lonDrive Turbo V a Nebulizzatore Riscaldato (a) Sistema AB SCIEX QTRAP®
6500 LM (Low Mass) (b) Sistema AB SCIEX QTRAP 6500 HM (High Mass) (c) Sistema AB
SCIEX Triple Quad™ 6500 LM (d) Sistema AB SCIEX Triple Quad 6500 HM

Tabella A-4 Parametri di Sistema QTRAP 6500 HM (High Mass) e LM (Low Mass) per le
Sole Scansioni di Tipo LIT

ID Accesso Modalita loni Positivi Modalita loni Negativi
CUR®) 20 20

da 10 a 55 da 10 a 55
CURMPB)A)BN7NE) 20 20

da 10 a 55 da 10 a 55
CAD Alto Alto

Basso; Medio; Alto Basso; Medio; Alto
1S(T2)7) 5500 -4500

da 0 a 5500 da-4500a0
1S®) 1500 -1500

da 0 a 2500 da-2500a0
1S(®) 1000 -1000

da 0 a 4000 da-4000a0
NC3)#)(@®) 3 -3

da0ab da-5a0
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Tabella A-4 Parametri di Sistema QTRAP 6500 HM (High Mass) e LM (Low Mass) per le
Sole Scansioni di Tipo LIT (Continua)

ID Accesso Modalita loni Positivi Modalita loni Negativi
TEM@E)N4)B)7)(E) 0 0
da0a 750 da0a 750
DP 100 -100
da 0 a 300 da-300a0
EP 10 -10
da2a15 da-15a-2
AF2 0,100 0,100
0o1 0o1
AF3 Dipendente -da Massa e Velocita Dipendente -da Massa e
da0a 10 Velocita
da0a10
EXB Dipendente -da Massa e Velocita Dipendente -da Massa e
da -165 a 0 Velocita
da0a165
CEM 1150 1150
da 0 a 3300 da 0 a 3300
GSH1 20 20
da0a90 da0a90
GS2 0 0
da0a90 da0a9o0
CES 0 0
da0a50 da0ab0
IE1 1 -1
daOab da-5a0
CE 10 -10
(QO0 - ROS) da5a180 da-180a-10
IHT(®) 150 150
da 0 a 250 da 0 a 250
sdp™ 1 1
102 102
(1)Sorgente ionica lonSpray™ (2)Sorgente ionica TurbolonSpray® Nebulizzatore
Riscaldato (4)Sorgente ionica DuoSpray™, 1=TIS, e 2=HN (5)Sorgente ionica
PhotoSpray® (6)Sorgente ionica NanoSpray® (7)Sorgente ionica lonDrive™ Turbo V
(8)Sorgente a Nebulizzatore Riscaldato lonDrive Turbo V
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Soluzioni e loni per la Calibrazione

Tabella B-1 Frequenza di Sintonizzazione

Calibrazione Ottimizzazione Risoluzione
Tipo Frequenza Manuale/Auto |Frequenza Manuale/Auto
Scansione
Q1eQ3 da 3 a 6 mesi Entrambi da 3 a 6 mesi Entrambi
LIT Ogni 2 Entrambi da 3 a 6 mesi Solo Auto
settimane;
secondo
necessita

Tabella B-2 Soluzioni Consigliate per la Sintonizzazione del Sistema AB SCIEX Triple
Quad™ 6500

Sistema
Sistema AB SCIEX Triple Quad 6500
(Low Mass e High Mass)

Positiva
2x10~" M PPG (1:500)

Negativa
3 x 10™ NEG PPG (1:10)

Tabella B-3 Soluzioni Consigliate per la Sintonizzazione del Sistema QTRAP® 6500

Q1eQ3 LIT
Strumento Positiva Negativa Positiva e
Negativa
Sistema QTRAP 6500 (Low 2x107"MPPG [3x 107 NEG PPG |[Agilent mix 1:100
Mass e High Mass) (1:500) (1:10)

Tabella B-4 PPG e PPG3000 per Q1 e Q3 in Modalita Positiva - Sistema AB SCIEX Triple
Quad 6500 (Low Mass)

Soluzione Masse
PPG 59,05 (68,1 99,1 175,133 |1 500,38 616,464 906,673 | 1080,79 | 1196,88
9 3
PPG3000 60,05 |74 175,13 |500,38 |616,46 {906,673 |1080,79 |1196,88 | —
3 4 9 3

Tabella B-5 PPG e PPG3000 per Q1 e Q3 in Modalita Negativa - Sistema AB SCIEX Triple
Quad 6500 (Low Mass)

Soluzione |Masse
PPG 44 998 91 249 585,385 933,636 1223,845
PPG3000 44 998 44 998 91 585,385 933,636 1223,845
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Soluzioni e loni per la Calibrazione

Tabella B-6 PPG e PPG3000 per Q1 e Q3 in Modalita Positiva - Sistema AB SCIEX Triple
Quad 6500 (High Mass)

Soluzione | Masse
PPG 59,05 (68,1 [99,1 |175, |500, 616,4 906, | 1080, | 1196, | 1254, 1545, 1951,
133 |38 64 673 |799 |883 |925 134 427
PPG3000 (60,05 |74 175, /500, |616, |906,6 1080 1196, |— — — —
133 38 464 |73 ,799 | 883

Tabella B-7 PPG e PPG3000 per Q1 e Q3 in Modalita Negativa - Sistema AB SCIEX Triple
Quad 6500 (High Mass)

Soluzione |Masse
PPG 44 998 |91 249 | 585,385 933,636 |1223,845 |— —_
PPG3000 44 998 [44,998 |91 |585,385 933,636 |1223,845 |1572,097 |1862,306

Tabella B-8 PPG, PPG3000 e Agilent per Q1 e Q3 in Modalita Positiva - Sistema QTRAP
6500 (Low Mass)

Soluzione Masse
PPG 59,05 (68,1 99,1 175,133 1 500,38 616,464 906,673 | 1080,799 |1196,8
83
PPG3000 60,05 |74 175,13 |500,38 |616,46 |906,673 |1080,79 |1196,883 | —
3 4 9
Agilent 118,08 322, (622,02 |922,01 |— — — — —
7 049 |9

Tabella B-9 PPG, PPG3000 e Agilent per Q1 e Q3 in Modalita Negativa - Sistema QTRAP
6500 (Low Mass)

Soluzione |Masse

PPG 44 998 91 249 585,385 933,636 1223,845
PPG3000 44 998 44 998 91 585,385 933,636 1223,845
Agilent 112,985 431,982 601,978 — — —

Tabella B-10 PPG, PPG3000 e Agilent per Q1 e Q3 in Modalita Positiva - Sistema QTRAP
6500 (High Mass)

Soluzione | Masse
PPG 59,05 (68,1 |99,1 |175, |500, 616,4 |906, |1080, |1196, | 1254, 1545, 1951,
133 |38 64 673 |799 |883 |925 134 427
PPG3000 [60,05 |74 175, /500, |616, |906,6 1080 1196, |— —_ —_ —_
133 38 464 |73 , 799 |883
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Tabella B-10 PPG, PPG3000 e Agilent per Q1 e Q3 in Modalita Positiva - Sistema QTRAP

6500 (High Mass) (Continua)

Soluzione | Masse
Agilent 118,0 | 322, |622, 922, |1521 |— —_ —_ —_ —_ —_ —_
87 049 (029 |01 ,972

Tabella B-11 PPG, PPG3000 e Agilent per Q1 e Q3 in Modalita Negativa - Sistema QTRAP
6500 (High Mass)

Soluzione | Masse

PPG 44 998 |91 249 585,385 933,636 [1223,845 |— —
PPG3000 44,998 [44,998 |91 585,385 933,636 |1223,845|1572,097 | 1862,306
Agilent 112,987 431,982 601,978 | 1033,988  1633,949  — — —
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Pulizia e Manutenzione

Pulire il sistema ed effettuare la manutenzione con regolarita per ottenere prestazioni ottimali.
Per informazioni sulla frequenza della sintonizzazione, fare riferimento alla Tabella B-1
Frequenza di Sintonizzazione a pagina119.

La tabella di seguito contiene un programma consigliato per la pulizia e la manutenzione del
sistema. Contattare un Tecnico Addetto alla Manutenzione per ordinare i materiali di consumo.

Tabella C-1 Attivita di Manutenzione del Sistema

Componente Frequenza Attivita Per ulteriori informazioni, fare
riferimento a...
Separatore di Secondo Pulire Pulire il Separatore di Interfaccia
interfaccia necessita
Separatore di Secondo Pulire Pulire la Parte Frontale del Separatore di
vuoto necessita Vuoto
Guida ionica Secondo Pulire Contattare un responsabile
QJet® necessita dell'assistenza tecnica (FSE) di AB
SCIEX.
Lenti Q0 e Q1 Secondo Pulire Contattare un responsabile
necessita dell'assistenza tecnica (FSE) di AB
SCIEX.
Filtro aria Ogni 6 mesi Verificare e Guida per il Personale Addetto alla
strumento pulire o Manutenzione
sostituire
Superfici dello Secondo Pulire Pulizia della Superficie
strumento necessita
Contenitore di Secondo Svuotare Svuotare il Contenitore di Raccolta
raccolta rifiuti necessita
Olio pompa per |Varian MS 40: | Sostituire Contattare un responsabile
vuoto Una volta dell'assistenza tecnica (FSE) di AB
I'anno SCIEX.
Elettrodo Secondo Verificare e Contattare un responsabile
necessita pulire o dell'assistenza tecnica (FSE) di AB
sostituire SCIEX.
Ago di scarica a |Secondo Sostituire Contattare un responsabile
corona necessita dell'assistenza tecnica (FSE) di AB
SCIEX.

Per le attivita "Secondo necessita", seguire queste linee guida:

» Pulire il separatore di interfaccia, il separatore di vuoto, la guida ionica QJet e la
regione del QO se la sensibilita del sistema peggiora.

»  Pulire le superfici dello spettrometro di massa dopo un eventuale fuoriuscita di
sostanze, o quando divengono sporche.

»  Svuotare il contenitore di raccolta rifiuti quando € pieno.
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Pulizia e Manutenzione

Contattare un rappresentante AB SCIEX per assistenza e supporto nella manutenzione.

Precauzioni in Materia di Salute e Sicurezza

Determinare quali prodotti chimici sono stati usati nello spettrometro di massa prima
di effettuare la manutenzione. Fare riferimento alle Schede di Sicurezza per le
precauzioni in termini di salute e sicurezza che devono essere prese quando si
trattano prodotti chimici.

Lavorare in un ambiente ben ventilato.

Indossare sempre i dispositivi di protezione individuale assegnati, inclusi guanti in
nitrile privi di polvere, occhiali di sicurezza e camice da laboratorio.

Seguire le norme di sicurezza relative ai lavori in presenza di elettricita.

Evitare le potenziali fonti di scintille quando si lavora coi materiali infiammabili, come
alcool isopropilico, metanolo e altri solventi infiammabili.

Fare attenzione nell'uso e nello smaltimento di qualunque prodotto chimico. Sussiste
il rischio di infortunio se le procedure corrette per il trattamento e lo smaltimento dei
materiali pericolosi non sono rispettate.

Evitare il contatto dei prodotti chimici con la pelle durante la pulizia e lavare le mani
dopo l'uso.

Operare in conformita a tutte le normative locali per il trattamento dei materiali
radioattivi, tossici o a rischio biologico.

é c AVVERTENZA!Rischio di Contaminazione da Radiazioni o Esposizione ad

Agenti Tossici Chimici e Biologici: Determinare se sia necessaria una
decontaminazione dello strumento prima di effettuare la pulizia. La
decontaminazione dovrebbe essere condotta prima della pulizia se sono
stati usati materiali radioattivi, agenti biologici, o agenti chimici tossici
con uno degli strumenti.

Attenzione:Rischio di Danni Allo Strumento: Sciacquare via con acqua qualsiasi traccia di
solventi detergenti contenenti sostanze acide. Non usare solventi clorurati in quanto
possono danneggiare i componenti della guida ionica QJet.

Pulizia della Superficie

Pulire le superfici esterne dello spettrometro di massa dopo un eventuale fuoriuscita di sostanze,
0 quando divengono sporche.

Pulire le superfici esterne con un panno morbido inumidito con acqua calda e
sapone.
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Svuotare il Contenitore di Raccolta

Svuotare il contenitore di raccolta rifiuti quando & pieno.

biologico in contenitori debitamente contrassegnati. Sussiste il rischio di
infortunio se le procedure corrette per il trattamento e lo smaltimento dei
materiali a rischio biologico non sono rispettate.

f AVVERTENZA!Materiali a Rischio Biologico: Depositare i materiali a rischio

1. Arresto del Sistema..
2. Svitare il contenitore di raccolta dal tappo.

Figura C-1 Contenitore di raccolta

Elem | Descrizione
ento

1 Collegamento allo spettrometro di massa

2 | Contenitore di raccolta (Il contenitore di raccolta &€ mostrato sul retro dello
spettrometro di massa per mettere in evidenza i punti di collegamento. Il
contenitore di raccolta in condizioni normali si trova sul lato dello
spettrometro di massa.

3 | Collegamento alla bocca di aspirazione

3. Smaltire i rifiuti.
4. Riavvitare la bottiglia al tappo.
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Pulizia della Parte Frontale

Pulire la parte frontale dello spettrometro di massa usando il metodo di pulizia ordinaria, allo
scopo di:

*  Minimizzare i tempi dei fermo macchina non in programma.
* Mantenere una sensibilita ottimale.

» Evitare le operazioni di pulizia piu impegnative, in quanto richiedono l'intervento del
servizio assistenza.

Sintomi della contaminazione: Perdita significativa di sensibilita e aumento del rumore di
fondo.

Quando ha luogo una contaminazione, per prima cosa eseguire una pulizia ordinaria. Pulire fino
alla parte frontale del separatore di vuoto (incluso). Se la pulizia ordinaria non risolve i problemi
di sensibilita, sara necessaria una pulizia completa.

Questa sezione fornisce le istruzioni per eseguire una pulizia ordinaria senza rompere il vuoto e
una pulizia completa a pressione atmosferica, dopo aver spurgato lo spettrometro di massa.

‘|| sicurezza, fare riferimento alle Precauzioni in Materia di Salute e Sicurezza per maggiori

*A Nota: Seguire tutte le normative locali in vigore. Per le linee guida relative a salute e
v * informazioni.

Nota: Per domande e ordinazioni relative alle parti consumabili, telefonare allo 877-
’ ] 740-2129 (solo Stati Uniti), o visitare www.absciex.com.

Attrezzi e Materiali Necessari

» Guanti senza polvere (consigliati in nitrile)
* Occhiali di sicurezza
» Camice da laboratorio

* Acqua fresca di alta qualita (acqua deionizzata da almeno 18 Mohm [DI] o acqua ultra pura
per HPLC). L'acqua aperta da tempo puo contenere contaminanti che possono ulteriormente
contaminare lo spettrometro di massa.

* Metanolo per HPLC o LC/MS, alcool isopropilico (2-propanolo) o acetonitrile.
» Soluzione detergente. Usare una tra le seguenti:

* 100% metanolo

* 100 % alcool isopropilico

» Soluzione acqua/acetonitrile 50:50 (preparata al momento)

 Soluzione acqua/acetonitrile 50:50 con 0,1% di acido acetico (preparata al momento)

Attenzione:Non usare solventi clorurati.

Tabella C-2 Strumenti e Materiali Disponibili da AB SCIEX

Descrizione Numero
Particolare (NP)

Tampone piccolo in poliestere (coesionato termicamente) 1017396
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Tabella C-2 Strumenti e Materiali Disponibili da AB SCIEX

Descrizione Numero
Particolare (NP)
Panno antipelo piccolo (11 cm x 21 cm); disponibile nel kit Consumabili WC018027

Buone Pratiche

AVVERTENZA!Rischio di Contaminazione da Radiazioni o Esposizione ad
Agenti Tossici Chimici e Biologici: Determinare se sia necessaria una
decontaminazione prima di effettuare la pulizia. La decontaminazione

dovrebbe essere condotta prima della pulizia se sono stati usati materiali
3@ radioattivi, agenti biologici, o agenti chimici tossici con lo strumento.

* Indossare sempre guanti puliti e privi di polvere per le procedure di pulizia.

* Dopo aver pulito i componenti dello spettrometro di massa e prima di rimontarli,
indossare un paio di guanti puliti.

* Non usare strumenti e materiali di pulizia diversi da quelli specificati in questa
procedura.

*  Preparare le soluzioni detergenti subito prima di iniziare la procedura, se possibile.

* Preparare e conservare tutte le soluzioni organiche e le soluzioni contenenti
materiale organico solo in contenitori di vetro pulitissimi. Non usare mai bottiglie in
plastica con tappo a beccuccio. | contaminanti possono percolare da queste bottiglie
e contaminare ulteriormente lo spettrometro di massa.

* Fare entrare in contatto solo la parte centrale del panno con la superficie dello
strumento. | bordi potrebbero perdere delle fibre.

~  Suggerimento!Avvolgere il panno intorno a un tampone in poliestere
/ coesionato termicamente.

&

g

Figura C-2 Esempio: Avvolgimento del panno

* Permettere al panno o al tampone di entrare in contatto con la superficie una volta
sola, poi gettarlo, per evitare la contaminazione incrociata.

* Le parti piu grandi dell'interfaccia di vuoto, come il separatore di interfaccia,
potrebbero avere bisogno di diverse passate, usando piu panni la volta.

* Per evitare di contaminare la soluzione, versare la soluzione sul panno o sul
tampone.
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* Inumidire il panno o il tampone solo leggermente quando si applicano acqua o
detergenti. L'acqua, piu dei solventi organici, puo causare il deterioramento del
panno, con conseguente rilascio di residui sullo spettrometro di massa.

Preparazione per la Pulizia

Nella pulizia ordinaria si devono pulire il separatore di interfaccia e la parte frontale del
separatore di vuoto. La pulizia ordinaria si pu0 effettuare mentre lo spettrometro di massa resta

sotto vuoto.

Wt

| Nota: Gli spettrometri di massa con una sorgente ionica NanoSpray® potrebbero
\,,/ richiedere una pulizia completa per ottenere i risultati migliori. Contattare un
" responsabile dell'assistenza tecnica (FSE) di AB SCIEX.

1. Disattivare il profilo hardware.

AVVERTENZA!Pericolo - Superfici calde: Le superfici della sorgente
& ionica lonDrive™ Turbo V raggiungono temperature considerevoli

durante il funzionamento. Lasciar raffreddare la sorgente ionica per

almeno 90 minuti prima di iniziare qualsiasi procedura di pulizia.

2. Rimuovere la sorgente ionica. Assicurarsi di sistemare la sorgente ionica in una
posizione sicura.

3. Attendere almeno 90 minuti per far si che il separatore di vuoto € il separatore di
interfaccia si asciughino.

4. Coprire lo scarico della sorgente con il suo coperchio (se disponibile) o un coperchio
della forma adatta.

Figura C-3 Sfiato della sorgente sull'interfaccia di vuoto

Elemento | Descrizione

1 Sfiato della sorgente
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Pulire il Separatore di Interfaccia

1. Rimuovere il separatore di interfaccia e sistemarlo su una superficie stabile e pulita.

Figura C-4 Interfaccia con il separatore di interfaccia rimosso.
Pulire ambo i lati del separatore di interfaccia usando panni e acqua.
Ripetere il passo 2 usando la soluzione detergente.
Pulire la fenditura con un panno inumidito o un tampone in poliestere piccolo.

Attendere fino a che il separatore di interfaccia sia asciutto.

o g bk~ w N

Verificare I'eventuale presenza sulla piastra di macchie di solvente o fibre,
rimuovendole completamente con un panno antipelo pulito e leggermente inumidito.

“«su Nota: Una pellicola o una macchiatura persistente indicano la
contaminazione del solvente.

=

4

Pulire la Parte Frontale del Separatore di Vuoto

“«ws Nota: Se il separatore di vuoto di serie ha un riscaldatore di interfaccia rimovibile, non
rimuovere il riscaldatore durante la pulizia.

=

' 4

1. Quando si effettua la pulizia su un separatore di vuoto NanoSpray, rimuovere il
riscaldatore di interfaccia e pulirlo:
i. Pulire il riscaldatore con un panno antipelo inumidito con acqua.
ii. Pulire il riscaldatore con un panno antipelo inumidito con la soluzione
detergente.

2. Inumidire leggermente il panno antipelo con acqua e poi pulire la parte frontale del
separatore di vuoto.

Attenzione:Rischio di Danni Allo Strumento: Non inserire fili o pennelli
metallici nell'orifizio, per evitare di danneggiare la fenditura.

3. Ripetere il passo 2 usando la soluzione detergente.
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4. Attendere fino a che il separatore di vuoto sia asciutto.

5. Verificare I'eventuale presenza di macchie di solvente o fibre sul separatore di vuoto,
rimuovendole completamente con un panno antipelo pulito e leggermente inumidito.

“«s Nota: Una pellicola o una macchiatura persistente indicano la
contaminazione del solvente.

N

Rimettere il Sistema in Funzione

Installare il separatore di vuoto sulla parte frontale dello spettrometro di massa.

Rimuovere la protezione dallo sfiato della sorgente ionica.

Installare la sorgente ionica sullo spettrometro di massa. Fare riferimento alla Guida
per I'Operatore della sorgente ionica.

4. Stringere la sorgente ionica ruotando i fermi di rilascio della sorgente in basso fino a
raggiungere la posizione di blocco (ore 6).

5. Attivare il profilo hardware.
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Risoluzione dei Problemi di Base del Sistema D

Questa appendice contiene informazioni generali sulla risoluzione dei problemi di base del

sistema. Alcune attivita in laboratorio devono essere eseguite solo dal Personale Addetto alla
Manutenzione formato da AB SCIEX. Per la risoluzione dei problemi complessi, contattare un
Responsabile dell'Assistenza Tecnica (FSE) di AB SCIEX.

Tabella D-1 Problemi del Sistema

Problema

Probabile causa

Intervento

Perdita di sensibilita

Lo strumento o la sorgente
ionica richiedono di essere
sintonizzate e ottimizzate.

Per ulteriori informazioni, fare
riferimento a:

» Calibrazione e
Sintonizzazione dello
Strumento

» Sorgente lonica lonDrive™
Turbo V - Guida per
I'Operatore

* Help del software Analyst®

Separatore di interfaccia
sporco

Fare riferimento a Pulire il
Separatore di Interfaccia per
maggiori informazioni.

Separatore di vuoto sporco

Fare riferimento a Pulire la
Parte Frontale del Separatore
di Vuoto per maggiori
informazioni.

Guida ionica QJet®, Q0 o 1Q0
sporchi

Contattare il Responsabile
dell'Assistenza Tecnica (FSE)
di AB SCIEX o il Tecnico
Addetto alla Manutenzione
locale qualificato AB SCIEX.

Contaminazione estrema o
frequente della guida ionica
QJet

La velocita di flusso del
Curtain Gas™ & troppo bassa.

Controllare la velocita di flusso
del Curtain Gas™ e
aumentarla, se del caso.

Bassa pressione di vuoto

Livello olio pompa per vuoto
basso.

Controllare il livello olio della
pompa per vuoto primaria e
aggiungere olio se necessario.

Contattare il Responsabile
dell'Assistenza Tecnica (FSE)
di AB SCIEX o il Tecnico
Addetto alla Manutenzione
locale qualificato AB SCIEX.
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Risoluzione dei Problemi di Base del Sistema

Per la manutenzione, I'assistenza tecnica o l'assistenza commerciale, contattare un
Responsabile dell'Assistenza Tecnica (FSE) di AB SCIEX o visitare il sito web AB SCIEX
all'indirizzo www.absciex.com per ottenerne il contatto.
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